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Description
This manual is issued for reference only, at the convenience of Arbiter
Systems. Reasonable effort was made to verify that all contents were
accurate as of the time of publication. Check with Arbiter Systems
at the address below for any revisions made since the original date of
publication.

Contact Information

Arbiter Systems, Inc.
1324 Vendels Circle, Suite 121
Paso Robles, CA 93446
(805) 237-3831
Website: www.arbiter.com
mailto: techsupport@arbiter.com
mailto: sales@arbiter.com

Definition
This manual describes the Model 933A Portable Power Sentinel�, Syn-
chronized Power Quality Meter and PSCSV� software.

Firmware and Firmware Updates
This manual was created based on version 1.06 of the main DSP pro-
gram, dated 17 September 2007. To display the firmware date, press
DISPLAY > 9-Config & Status > the Version & S/N soft key.

Firmware Updates are available from Arbiter Systems website or by
contacting technical support at the information above.
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LIMITED WARRANTY
Arbiter Systems makes no warranty, expressed or implied, on any prod-
uct manufactured or sold by Arbiter Systems except for the following
limited warranty against defects in materials and workmanship on prod-
ucts manufactured by Arbiter Systems.

Products manufactured by Arbiter Systems are guaranteed against de-
fective materials and workmanship under normal use and service for
one year from the date of delivery. The responsibility of Arbiter Sys-
tems under this warranty is limited to repair or replacement, at Arbiter
Systems’ option, of any product found to be defective. Arbiter Systems
shall have no liability under this warranty unless it receives written no-
tice of any claimed defect, within the earlier of:

� Thirty days of discovery by Buyer, or;

� One year from the date of delivery.

For warranty service or repair, products must be returned to a service
facility designated by Arbiter Systems. Buyer shall prepay all shipping
charges to Arbiter Systems, and Arbiter Systems shall pay shipping
charges incurred in returning the product to Buyer. However, Buyer
shall pay all shipping charges, duties and taxes for products returned
to Buyer in a country other than the United States of America.

THE WARRANTY SET FORTH HEREIN CONSTITUTES THE
ONLY WARRANTY OBLIGATIONS OF ARBITER SYSTEMS, EX-
PRESSED OR IMPLIED, STATUTORY, BY OPERATION OF LAW,
OR OTHERWISE. ARBITER SYSTEMS DISCLAIMS ANY WAR-
RANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICU-
LAR PURPOSE, AND BUYER EXPRESSLY WAIVES ALL OTHER
WARRANTIES.

This limited warranty does not extend to any product, which has been
subject to

I Improper use or application, abuse, or operation beyond its rated
capacity, or contrary to the instructions in the operation and main-
tenance manuals (if any);

II Accident;

III Repair or maintenance performed by Buyer, except in accordance
with the operation and maintenance manuals, if any, and any spe-
cial instructions of Arbiter Systems;
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IV Modification without the prior written authorization of Arbiter
Systems (whether by the substitution of non-approved parts or
otherwise).

The remedies provided herein are Buyer’s sole and exclusive remedies.
In no event shall Arbiter Systems be liable for direct, indirect, incidental
or consequential damages (including loss of profits), whether based on
contract, tort, or other legal theory.

FOR THE FASTEST POSSIBLE SERVICE, PLEASE PROCEED AS
FOLLOWS:

1. Notify Arbiter Systems, Inc., specifying the instrument model
number and serial number and giving full details of the difficulty.
Service data or instrument-return authorization will be provided
upon receipt of this information.

2. If instrument return is authorized, forward prepaid to the man-
ufacturer. If it is determined that the instrument is not covered
by this warranty, an estimate will be made before the repair work
begins, if requested.

See Contact Information on page ii.
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Chapter 1

Introducing the Model
933A

1.1 Scope

The Model 933A Portable Power Sentinel is designed to provide highly-
accurate measurement of electrical power quality and many other elec-
trical values important to the power industry. A true seven-channel
instrument, the Model 933A allows independent measurement of three-
phase currents and voltages (including neutral), and associated values.

Designed for data recording and storage, memory is divided between
two 128-MB flash cards. One memory card receives data at the highest
sampling rate directly from the DSP for waveform data storage, and
the other memory card stores the more accurate, standard data after
processing.

To enhance portable operation, the 933A includes a common IEC-320
power inlet connector for normal operation or for charging the internal
Nickel Metal Hydride (NiMH) battery.

While the 933A was designed to operate independently in portable
situations from the front panel, its capability is enhanced through using
PSCSV software.
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1.2 Included Accessories

The Model 933A comes with a standard AC power cord, a ground lead
with clip, an RS-232 cable/adapter and operation manual.

Figure 1.1: 933A with Accessories
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1.3 933A Features

Listed below are some of the most obvious and significant features of
the Model 933A, Portable Power Sentinel. While many of the most
significant features of the 1133A Power Sentinel are present, the 933A
embodies some additional features that make it uniquely important as
a synchronized power measurement device.

1.3.1 Features and Accessories

� Seven-Channel Measurement, including three voltage, three cur-
rents plus neutral current.

� Separate tabular and graphical indications of each measurement
channel, including voltage, current, power values, power factor
and frequency. Includes Min/Max values and Average.

� Harmonic Measurement out to the 50th harmonic in both graph-
ical and tabular format.

� Waveform analysis, including high-speed waveform capture

� Sophisticated Triggering from the DSP and external signals

� Power quality, energy, phasor, combined measurement viewing

� Optional current modules for low range, seven-channel measure-
ment

� Auxiliary I/O Module for timing external events and controlling
relay contacts

� GPS module for synchronized measurement

� Two separate 128 MB flash memory cards for storing regular data
and high-speed waveform data

� Dual inlet power, including wide range AC/DC supply and
rechargeable Nickel Metal Hydride battery

� PSCSV Application software to configure the 933A and control
measurement; use either the RS-232 or USB interface.
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1.4 Available Accessories

� Current and Voltage Lead Sets

� Adjustable Bail Assembly

� 400 Amp Direct Current Transformer

� 100 Amp Clamp-on CT, current output

� 100 Amp Clamp-on CT, voltage output

� Low Current Modules

� GPS Antenna Module

� Auxiliary I/O Module

1.4.1 Lead Set Information

Arbiter Systems offers test lead wire with your choice of two insulation
types, Santoprene and silicone. Both silicone and Santoprene insulated
lead wires are made using finely-stranded rope-lay copper conductors
for exceptional flexibility and limpness.

Silicone is our premier test lead wire. Highly flexible over a wider range
of temperatures (-70 to +150 C, -100 to +300 F) than any other flexible
insulation material, with excellent resistance to damage due to flame
and heat, our silicone wire is highly recommended where safe operation
is required with the possibility of high-current through faults. Silicone
is nonflammable, and will not emit toxic or irritating fumes at extreme
temperatures or under overload conditions.

For most applications, our Santoprene insulated test lead wire is a cost-
effective alternative to silicone, offering most of the same advantages
at a price which compares favorably with PVC, neoprene, and other
lower-quality insulations. Because Santoprene is a thermoplastic rub-
ber, however, it will melt at a temperature of +216 C (+421 F), and
it is primarily recommended for use in applications where high-current
faults are less likely. Santoprene offers excellent resistance to arc igni-
tion and good resistance to ignition by a hot wire. And, unlike PVC
or halogenated rubber compounds, Santoprene does not emit toxic and
irritating fumes when it is overheated or burned, and it is inherently
self-extinguishing.
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1.4.2 813AT Three-Phase Voltage Lead Set

The 813AT is a three-phase, four-wire lead set that provides safety-
shrouded stackable 4-mm banana plugs on both ends of the lead set;
includes various plug-on accessories compatible with the 4-mm banana
plugs. This lead set is assembled with #16 Santoprene-insulated lead
wire; leads are protected by gray PET armor and include a Velcro lead
strap.

Figure 1.2: 813AT Voltage Lead Set

Intended primarily for applications where high-energy faults are un-
likely. For high-energy applications, see the Model 815AT Three-Phase
Fused Safety Voltage Probe Lead Set.

1.4.3 813BT Three-Phase Voltage Lead Set

The 813BT is identical in construction to the 813AT, except that this
lead set is assembled with #16 AWG Silicone-insulated lead wire. Sili-
cone is our premier test lead wire. Highly flexible over a wider temper-
ature range (-70 to +150◦C, -100 to +300◦F) than any other flexible
insulation material, with excellent resistance to damage due to flame
and heat, our silicone wire is highly recommended where safe operation
is required with the possibility of high-current through faults.
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1.4.4 816AT Three-Phase Spade Lug, Current Lead
Set

The 816AT is a three-phase current lead set, equipped with 1/4-inch
spade lugs on both ends. Spade lugs are gold-plated for long life in
demanding service, and have oversized barrels to accommodate our
finely stranded test lead wire. This lead set is assembled with #10
Santoprene-insulated lead wire, has overall gray PET armor and a Vel-
cro lead strap.

Figure 1.3: 816AT Current Lead Set

1.4.5 816CT Three-Phase Spade Lug, Current Lead
Set

Identical to the 816AT, the 816CT is constructed with Silicone-
insulated lead wire, instead of Santoprene-insulated lead wire.
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1.4.6 811AT Universal Test Plug Current Lead Set

Assembled with our Universal Test Plug on one end and 1/4-inch spade
lug on the other; compatible with ABB/Westinghouse, Superior, Meter
Devices and States series test jacks. Materials and assembly are similar
to the 816AT Three-Phase Spade Lug, Current Lead Set.

Figure 1.4: 811AT Universal Test Plug Current Lead Set
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1.4.7 AS0035901 Adjustable Bail

Order the adjustable handle/bail assembly for convenient bench top
use that allows positioning the Model 933A at common angles to the
viewer. Adjust handle/bail by loosing the two fastening knobs, moving
the handle/bail to the desired position and tightening the two fastening
knobs.

Figure 1.5: 933A Case Bail Assembly
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1.4.8 Model 09311A, 400 Amp, Auxiliary CT

The Arbiter Systems, Inc. Model 09311A 20:1 Auxiliary Current Trans-
former extends the outstanding accuracy, features and performance of
the Model 933A Portable Power Sentinel by increasing the current in-
put capability to 400 Amperes. Due to the careful design of the Model
09311A Auxiliary CT, overall accuracy exceeds 0.1% of reading and 0.1
degrees over the entire input current range of 1 to 400 amperes.

1.4.9 AP0009800, 100 Amp, Clamp–on CT

The AP0009800 100:1 Clamp-on CT has a primary current range of
1 to 100 Amps. It has shrouded banana connectors on the secondary,
and an input range of up to 600 Volts, CAT III.

1.4.10 933A-02 / 933A-03, Low Current Modules

Two low-current input modules are available for both current-output
and voltage-output CTs. Each has two ranges; a high range (up to
1.2 Arms or 2.4 Vrms) and low range (up to 50 mA rms and 100 mV
rms) These two modules are very similar except for the input connec-
tors. The 933A-02 has two sets of shrouded banana connectors for
each phase, including neutral, that include a voltage input and current
input. The 933A-03 has a unique single jack that allows for voltage
and current input signals. Arbiter Systems produces dedicated cable
assemblies for the Model 933A-03 to work with this current module.

Figure 1.6: 933A-02 and 933A-03 Low Current Modules
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1.4.11 AS0077600, GPS Antenna Module

To synchronize the 933A with the GPS, order the GPS Antenna Module
(Part No. AS0077600). It includes 50 feet of special cable that attaches
between the front panel of the 933A and the GPS module. The antenna
module provides the best accuracy for 933A timing measurements.

Operating at the standard GPS frequency (L1 band) of 1575.42 MHz,
the antenna module receives power from the 933A through the cable
assembly. The same cable assembly communicates time and position
data via RS-485 to the 933A.

If connected before power up, the Model 933A automatically recognizes
the GPS module and sets the internal clock on the Model 933A to the
correct time. If the GPS module is connected after power up, use
the manual programming function to synchronize the 933A. See Clock
Time Setup Menu in Chapter 3. The photo below shows the standard
cable assembly with the magnet-mounting bracket.

Figure 1.7: GPS Antenna Module and Cable Assembly
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1.4.12 AS0077700, Auxiliary I/O Module

The AS0077700, Auxiliary I/O Module, connects to the AUXILIARY
I/O input connector and has two major features:

� Four Event Input connections

� Three sets of relay contacts: two Form-C, mechanical contacts
and one solid-state contact (KYZ rated)

Event Input Configuration

To set up the Event Inputs in the External I/O Module see page 106
for details.

Relay Contact Configuration

To set up the three relay contacts in the External I/O Module see page
108 for details.

Figure 1.8: External I/O Module and Cable Assembly
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1.5 Safety Information

Read the safety information before using the Arbiter Model 933A. Spe-
cific warning and caution statements, where they apply, will be found
throughout the manual.

In general, be very careful when working around high voltages and
sources of current. It is possible to receive an electrical shock that
could severely injure you or cause death.

1.5.1 Definitions

� A Warning identifies conditions and actions that may pose haz-
ard(s) to the user.

� A Caution identifies conditions and actions that may adversely
affect the performance of, or damage to, the Arbiter Model 933A.

� Read the Safety Information in the manual.

1.5.2 Warnings

� The maximum allowable input to either set of Voltage terminals
is 650 Vrms. Over range is 1200 Vpeak, nominal.

� The maximum allowable input to the current terminals is 40 A
peak and 20 Arms continuous.

� Remove all test leads that are not in use.

� Connect the supplied ground lead to a suitable earth ground when
operating the Model 933A under battery power.

1.5.3 Terminology

The terms “Isolated” or Electrically Floating” are used in this manual
to indicate a measurement in which the Model 933A is not connected
to earth ground through the ground terminal on the front panel.

The term “Grounded” in this manual refers to a measurement in which
the Model 933A is connected to an earth ground.
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Ground Lug

The purpose of the ground lug is to connect the chassis to a safety
ground, especially during battery operation.

Warning

The front-panel ground terminal should always be connected to the
safety ground for the circuit under test. This is especially critical for
operation with the line cord unplugged, since the AC line input safety
ground will not be connected.

Current Probe

Arbiter Systems may supply various current probes based on availabil-
ity, and considers them as accessories to the Model 933A. Make sure to
stay within the limitations of the 933A if supplying your own current
probe.

1.5.4 Additional Warnings

� Use extreme caution when clamping the current probe(s) around
non-insulated conductors or buss bars.

� Never use the current probe on circuits rated higher than 600
Vrms in overvoltage category III (CAT III) or EN/IEC61010-1.

� Keep your fingers behind the finger guard.

� Do not use a probe that is cracked, damaged, or has a defective
cable. Such probes should be made inoperative by taping the
clamp shut to prevent operation.
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Chapter 2

Basic Operation

2.1 Introduction

“Basic Operation” describes all of the 933A keys, connectors and
menus, and how to operate the Model 933A primarily from the front
panel buttons. You may also remotely control the 933A from a com-
puter running PSCSV� application software. Additional information
on PSCSV� software is located throughout the manual where needed
and in Chapter 6, entitled, “PSCSV Basics”.

2.2 Powering the Model 933A

2.2.1 Operation with the AC Power Cord

The Model 933A can be operated from an AC outlet or from an internal
rechargeable battery pack. To operate with the AC power cord,

1. Plug the power cord into the AC outlet (see External Power,
under Specifications).

2. Connect the power cord to the 933A.

3. Press the ON/OFF key to turn on the 933A and the splash screen
will appear on the display.

4. Following the splash screen, the 933A will settle on the DISPLAY
SELECTION screen for viewing measurements.
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2.2.2 Operation with Battery Power

The Model 933A comes equipped with an internal, NiMH battery pack;
charge by connecting the 933A with the included power cord to an AC
outlet, or external DC Power. Under battery power, the Model 933A
should run for at least 8 hours on a full charge. Operating the 933A
using the LCD backlight will reduce the operating time.

2.2.3 Charging the Internal Battery

To charge completely,

� Connect the power cord between the outlet and the 933A.

� Power OFF the 933A and charge for at least 5 hours.

A battery charge level indicator is visible as part of the Status Indica-
tors in most of the data viewing screens. The level of charge is indicated
by the dark color in the battery symbol. The battery symbol in the
screen shot below indicates that the charge level of the internal battery
is full.

Warning

When operating the 933A under battery power, make sure to connect
the ground lug on the front panel to a handy ground point (see Chassis
Ground later in this section). Otherwise, the 933A will be floating.

For more information on battery status, please see Section 2.4.12 on
page 28.
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Battery information is also available when selecting configuration and
status information. Select DISPLAY > 9–Config & Status > BAT-
TERY & FLASH (soft key) to view the screen shot in Figure 2.1.

Figure 2.1: Battery and Flash Status Screen

BATTERY STATUS

Values listed under BATTERY STATUS are for factory use when trou-
ble shooting a problem with the unit. You may be asked to report these
values if you suspect a battery problem.
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2.3 Controls and Connections

Figure 2.2: Front Panel Description
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2.3.1 Inputs and Interface

Front Panel Keys

The 933A has thirty front-panel keys with the following general uses:

� Soft Function Keys (5)

� Dedicated Function Keys (8)

� Cursor control with Enter key (5)

� Numeric keypad (12)

2.3.2 Front Panel Connectors

Connectors on the 933A have the following purposes:

� Current (C) and voltage (V) input; (C) 4, 6, 16, (V) 4

� Ground/safety lug, banana

� Multiconductor GPS Timing Input; capped when not in use

� IRIG-B Timing Input connector, BNC

� USB 1.1 serial I/O communications

� RS-232C serial I/O communications, RJ-11

� Multiconductor Auxiliary I/O; capped when not in use

� IEC-320 inlet power receptacle, with fuse compartment

2.3.3 Chassis Ground

A ground lug is located in the upper right portion of the front panel.
This terminal is connected to the instrument chassis, and also to the
safety ground lead of the AC power connector. When the Model 933A
is operated with the power line cord connected, the chassis of the in-
strument will be connected to the safety ground for the AC outlet.
However, when operated from the internal battery with the power cord
disconnected, the chassis will be floating.

The purpose of the ground lug is to allow the chassis to be tied to a
safety ground, especially during battery operation.

CAUTION: Do not use a 3-to-2 prong plug adapter on the ac power
cord. This will isolate the safety ground on the instrument from a
ground point and cause a dangerous condition.
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2.3.4 Voltage Inputs, 650 Vrms

Four input connectors are available for measuring AC voltages. All
four of the inputs use identical circuitry, which allow for measurement
of voltages up to 650 Vrms between inputs. See Figure 2.3 below.

Safety-insulated banana jacks are used to connect voltage signals to the
933A, are labeled “A”, “B”, “C”, “N” (for phase A, phase B, phase C
and Neutral, respectively), and have one megohm voltage dividers tied
to a common point. Any unused voltage input will float at the average
value of the used inputs. You can measure voltage between any two
of the inputs (e.g., A and N, or A and B), including any input and a
synthesized neutral. Synthesized neutral is the average of the voltages
at inputs A, B, and C. The 933 does not directly measure Vac or Vbc.

2.3.5 Current Input Module, 20 Arms (933A-01)

The Model 933A-01 Current Module has three inputs, A, B and C, for
use in AC current measurement. Each of the inputs uses a pair of five-
way binding posts, and has a maximum continuous current capability
of 20 amps rms. Peak current is 40 Arms, maximum. See Figure 2.3
below. For information on alternate plug-in modules (933A-02 and
933A-03) that offer lower current ranges and different connector styles,
see Section 1.4.10. Optional modules provide connectors for measuring
neutral current.

Figure 2.3: Voltage and Current Inputs
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2.3.6 Synchronizing the 933A

While the 933A does not require any external timing signal because of
its internal real-time clock, it can be synchronized with either a GPS
or IRIG-B input. Using either of these two external timing signals
will keep the 933A oscillator on frequency and all of the measurements
synchronized to within one microsecond of UTC.

When not connected to an external timing signal, the internal clock
runs off of the crystal oscillator and typically has a drift of less than
one second per day. When connected to the GPS, the time base error
is less than 1 microsecond when locked to at least one satellite. When
locked to an IRIG-B signal, the time base error will be less than one
microsecond plus the accuracy of the IRIG-B source.

Using the accessory GPS module (see Section 1.4.11), or an available
unmodulated IRIG-B signal, you can easily connect these signals to the
Model 933A for additional accuracy and synchronized measurements.
The following paragraphs will assist you with setting up and using these
features.

2.3.7 GPS Timing Signals

To use the Global Positioning System (GPS) as the phase reference
for synchronizing the 933A you must have the Arbiter GPS module
connected to the GPS connector located on the 933A front panel. Also,
the GPS module must be locked to the GPS. Since the GPS receiver and
antenna are housed in the same (external) module, it receives power
from the 933A and sends down-converted timing signals through the
cable via RS-485.

GPS Setup

1. Mount the GPS module in a stable manner in which the antenna
module has a clear view of the sky in all directions. If this is not
possible, a partial view of the sky may also work.

2. Turn off power to the 933A and connect the cable between the
933A and the GPS module.

3. Press the power switch to turn on the 933A.

4. Once connected and operating, the 933A should detect the pres-
ence of the GPS signal as the time reference. If you connect the
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GPS signal with the 933A powered on, you will need to select
SETUP > 1-Clock Time Set > ACTIVATE GPS RCVR.

2.3.8 IRIG-B Timing Signals

To accurately synchronize the 933A to an IRIG-B signal as a reference,
you must have a good IRIG-B signal connected to the IRIG-B IEEE
1344 BNC connector on the 933A. This is an unmodulated IRIG-B (DC
Level Shift) signal. See also Clock Time Setup Menu on page 32.

IRIG-B Setup

1. Connect the IRIG-B signal cable to the IRIG-B connector (BNC)
on the front panel of the 933A.

2. Once connected and operating, the 933A will automatically de-
tect the presence of the IRIG-B signal and adjust the internal
real-time clock.

2.3.9 Communication Ports

The Model 933A has two communications ports located on the front
panel; USB 1.1 and RS-232C. Both communication ports serve to pro-
vide a configuration and data acquisition link to the 933A.

Use PSCSV� software to maximize the operation of the 933A. While
most features are available from the front-panel keys, use PSCSV� soft-
ware to download data and also configure features.

While PSCSV� is the recommended application software, the 933A
can send a single bitmapped file to a terminal or computer running a
terminal program and pressing the Print key. For more information on
downloading bitmapped data, see Bitmapped File Downloading at the
end of this chapter.

USB 1.1

With the USB port, use PSCSV� to connect to and communicate
with the 933A. To link the Model 933A to a computer, first you will
need to connect the included USB cable between them. Next, open a
connection with the 933A using PSCSV� software. See Chapter 6,
“PSCSV Basics”.
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RS-232C

For RS-232C communications use PSCSV�software, or for bitmapped
downloads, use a terminal program like Hyper Terminal. Access the
RS-232 port through a small RJ-11 connector on the front panel us-
ing the included 6-foot phone cord and RJ-11 to DB-9F null-modem
adapter. To connect the 933A to a computer using PSCSV� software,
see Chapter 6, “PSCSV Basics.” To connect using a Terminal program,
see “Bitmapped File Downloading” at the end of this chapter.

2.3.10 Auxiliary I/O Port

The Auxiliary I/O port provides a connection between the Auxiliary
I/O Module (part no. AS0077700) and the 933A using the accessory
cable assembly. The Auxiliary I/O Module includes four event input
connections and three contact outputs: 2 Form-C mechanical contacts
and one solid-state contact. Connect wiring to the module using the
screw-terminal strip connectors.

2.3.11 IEC-320 Power Inlet Connector

To provide a connection to a wide range of AC and DC power inlet
sources, the 933A has one IEC-320 Power Inlet Connector. AC sources
include voltages between 85 to 264 Vac at 47 to 63 Hz, and DC sources
from 110 to 275 Vdc. A small door at the bottom of the connector
contains a fuse and space for a spare fuse.

Replacing a Fuse

1. Make sure that the 933A is powered OFF and disconnect the
power cord if attached.

2. Using a small flat-blade screwdriver, pry open the small fuse door
below the power connector. Pull it out toward you.

3. The innermost fuse is the one being used, and the fuse closest to
the door is a spare.

4. Check the suspected fuse for being open, and replace only with a
fuse of the same type.

Replacement Fuse, Part No. FU0001816; 1A, 250V, fast acting,
5 x 20-mm (diameter x length)
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2.4 Function Keys

In the following pages you will find descriptions for the main func-
tions of the Model 933A. Access these functions through either
PSCSV� software, or by using the 30 front-panel keys. Each key is
inscribed with a specific function name or symbol depicting the func-
tion.

� Eight specific function keys include: Power ON/OFF, Display
Backlighting, Display Functions, Review, Log (Data), Setup (in-
strument), Print (a record) and Hold (a reading)

� Twelve numeric data entry keys: data entry or function selection

� Five cursor control keys: right, left, up, down and Enter

� Five soft function keys; change with function

2.4.1 On/Off Key

Press and release the On/Off key to switch the power to the 933A on
or off.

2.4.2 Display − Viewing Current Data

Press the DISPLAY key to select the type of data you want to view on
the 933A display. This includes the active signal(s) connected to the
933A and all of the DSP-related parameters. It also includes any stored
records and related data residing in flash memory. Select to view data
using the associated number key, or by using the up or down cursor
key, then press the enter key.

Figure 2.4: Display
Key Menus
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2.4.3 Setup − Configuring the 933A

Press the Setup key to configure all of the features controlling the op-
eration of the 933A. For example, before actually connecting the 933A
to a circuit, it should be configured to match the measured electrical
system. Whether it is single phase or three phase, with two, three or
four elements, the 933A is adaptable to most of the commonly-wired
systems. Configure triggers from the setup menu so that the 933A is
ready to record events when they occur. Also, you can set up the Au-
tolog feature to automatically record the connected signals on a specific
day and over a set time interval. For accurate low currents measure-
ments, configure the 933A with one of the low-current modules (see
Sections 1.4.10 and 3.8).

Figure 2.5: Setup
Key Menus

Chapter 3 covers all of the setup and configuration features that control
how the 933A operates. This includes the type of measured electrical
system, setting up the internal clock, setting up the serial (RS-232)
port, configuring the automatic data logging features, setting up cur-
rent transformers and potential transformers, setting up current mod-
ules and triggering.

2.4.4 Five Soft Keys

Press any of these keys when the correct label appears in the lower
line of the display that indicates your choice. These keys may change
function whenever a specific function key, or other soft key, is pressed.

Figure 2.6: Five Soft Keys
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2.4.5 Display Lighting Key

Press the Display key to view the display lighting menu and adjust it.
Three display menu choices are available: BACKLIGHT ON, BACK-
LIGHT OFF and BACKLIGHT AUTO-OFF. BACKLIGHT AUTO-
OFF provides display backlighting for a period of 10 minutes and shuts
off the backlighting after 10 minutes have expired to save the internal
battery and extend the lifetime of the backlight. The cursor keys pro-
vide control over the backlight intensity and contrast. See Figure 2.7.

Figure 2.7: Brightness
Contrast Adjustment

Auto-Off and Backlight Life Expectancy

Note: Backlight life expectancy is about 1000 hours. Therefore, it is
good to use the Auto-Off feature to prolong the use of the backlight. If
you do intend to use the Display ON feature, it would be wise to turn
it off at the end of a sustained period of use.

2.4.6 Cursor Keypad / Enter Key

Press any of the Cursor Keys, including the Enter Key (the central key
with dot), to move through menu choices and to make selections. See
Figure 2.8 below.
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2.4.7 Numeric Keypad

Use any of the numeric keys to select various menu items or to enter
data into the Model 933A. When entering numeric data, use the right
or left arrow key to move the cursor to the right or left digits. See
Figure 2.8 below.

Figure 2.8: Numeric
and Cursor Keypad

2.4.8 Log Key

Press the Log key to immediately record a complete set of data to flash
memory. When retrieving data, the record type will be listed as “K”
(see below under Review Key).

2.4.9 Review Key

Press the Review key to view the contents of records stored in the flash
memory module. Records are displayed in chronological order accord-
ing to date and time and contain various identifiers, including what
initiated the recording. For more information on reviewing recorded
data, go to Chapter 5.

� Autolog recording - record type “A”

� Pressing the LOG button - record type “K”

� User Triggers - record type “T” (Trigger with up/down arrow
indicating that the trigger is active/inactive)

� Sag Swell Triggers - includes high-speed waveform records (T)

� Triggered from optional External I/O Module (T)

Review Key Selections

Press the number of the record displayed (0 − 9) to select and view
specific data. Use Arrow keys to scroll though logged data.
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2.4.10 Print Key

Press the Print key to send the information, exactly as it appears on the
933A display, to the RS-232 port. The 933A sends out this information
in a bitmapped file format. Therefore, to receive this file, you would
need to have a terminal program running and set to the same RS-232C
port settings as in the 933A. See “Serial Setup (RS-232 Port Settings)”
later in this chapter. The file size is normally about 10 kilo Bytes.

Format: X Modem - CRC

Use the DISPLAY key to cancel the transfer.

To capture a bitmapped file, use a terminal program, like Hyper Termi-
nal or Tera Term Pro; See Section 2.6 “Bitmapped File Downloading”
later in this chapter.

2.4.11 Hold Key

Press the Hold key to alternate between the Measurement Mode and
Hold Mode. The Hold Mode freezes the display and displays the cur-
rent data at the time that you press the Hold key. During the Measure-
ment Mode, the indicator in the meter symbol is moving. The 933A is
normally placed in Hold Mode when reviewing data recorded in flash
memory.

2.4.12 933A Status Indicators

A set of status indicators, located in the lower left of the 933A dis-
play, describe the instrument operating modes, including time and date.
These symbols appear when viewing any data in the Measurement or
Hold Mode. Figure 2.9 below provides definitions for each of these
indicators.

Battery Level

On a full charge, the battery symbol should be completely dark and the
battery giving the 933A about 8 hours of operation. When the battery
is drained, the symbol appears as an outline of the battery symbol and
may have the letter L to indicate that the charge is Low, or the letter
C to indicate that it is Charging.
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Figure 2.9: Status Indicator Definitions

Data Modes

There are five data modes for storing and handling data, including (1)
Key Logging − logging one record to flash by pressing the LOG key,
(2) Auto Logging − logging multiple records to flash using the Autolog
feature, (3) Trigger Log − notification of triggered data being held in
flash, (4) Review Data − notice that you are reviewing data stored
in flash, and (5) Send Data − stored data being sent to one of the
communication ports.

Timing Modes

There are three timing modes: (1) Unlocked− the free-running Internal
Clock, (2) Locked to IRIG-B − Internal Clock synchronized to an in-
coming unmodulated IRIG-B signal, and (3) Locked to GPS − Internal
Clock synchronized to an incoming GPS signal. When synchronized,
we refer to the internal clock as being “Locked.”

Viewing Modes

There are two viewing modes: (1) Measurement Mode, and (2) Hold
Mode. Press the HOLD key to alternate between the Measurement
Mode and Hold Mode. The Hold Mode freezes the display and displays
the current data at the time that you press the HOLD key. During the
Measurement Mode, the indicator in the meter symbol is moving.
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Date and Time

The 933A status indicators also provide you with the current Date, Day
of Week, and Time. In free running mode, you must manually set the
date and time for them to be correct. With a connected IRIG-B or GPS
synchronizing signal, the date and time are set automatically, and kept
accurate. Note: Use the correct IRIG-B type. Set the clock source
to unmodulated IRIG-B, with IEEE 1344 Mode ON. Status Indicators
will state NO DATE DATA and NO TIME DATA if set to any other
type of IRIG-B.

Internal Clock

The internal clock has three modes: (1) free running based on the
internal oscillator, (2) synchronized by an external IRIG-B signal, and
(3) synchronized by an external GPS signal. Timing Mode indicators
show the current mode as seen in the main figure on the previous page.

In the free-running mode, the clock drift is based on both the physical
characteristics of the clock and operating environment; namely, the
ambient temperature. Unlocked, the clock accuracy is less than 10
PPM and less than 1 second per day, typical. Make sure to check, and
if necessary set, the clock time before important measurements. If not,
time-based measurements, such as set up under the Autolog mode, may
not occur as anticipated.

Synchronized to an IRIG-B signal, the accuracy will be 1 microsecond
plus the accuracy of the IRIG-B signal. The 933A indicates IRIG-B
synchronization with a symbol of a digital signal. The internal clock
will be set only if the IRIG-B is unmodulated and according to the
IEEE 1344 standard.

Synchronized to the GPS, the accuracy is 1 microsecond. The internal
clock (time and date) will be set automatically.

2.5 PSCSV Software

PSCSV� software was developed by Arbiter Systems to manage all
of the programming and data logging functions in the Model 933A.
While most features are accessible from the front panel, some are only
available with PSCSV� software. It is an included accessory when you
purchase the Model 933A, and gives you full control configuring 933A

30



functions and transferring data from the Model 933A to a connected
computer.

Complete information on using PSCSV� software is found in Chap-
ter 6, “PSCSV Basics.”

2.5.1 USB or RS-232C

Connect to the 933A USB or RS-232C ports using PSCSV�. Make sure
that PSCSV� is installed on your PC and connect a suitable cable
between them. Included as an accessory is a DB-9F to RJ-11 adapter
and phone cord for connecting between the 933A and RS-232C port
on a computer. If your computer does not have an RS-232 port, use a
USB-to-RS-232 adapter. A standard USB cable is also included.

2.5.2 Connecting

Before using PSCSV�, make sure that you read over the section on
connecting in Chapter 6, PSCSV Basics. It is necessary to manually
connect to the 933A from the computer running PSCSV� software.

2.5.3 Configuring

Configure all SETUP functions through PSCSV� or through the front
panel keys.

2.5.4 Downloading Data

When downloading data, all of the data is in binary format and can
be located in the directory of your choice on the computer running
PSCSV�.
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2.6 Bitmapped File Downloading

Purpose

The PRINT key has one basic function: to send a bitmapped file of the
current display to the RS-232C port.

Procedure

1. Verify the RS-232 settings by selecting DISPLAY > 9- Config &
Status. If you need to change the SERIAL settings, then you
would press the SETTINGS key and 2- Serial Setup. Adjust the
settings and go to step 2.

2. Open a terminal program of choice and make sure that the port
settings agree with those from step 1 above. Change them if
necessary.

3. Set the 933A to read the desired information on the display.

4. Set the terminal program to Transfer the file via Xmodem Re-
ceive. This is done with slight differences between programs.

5. When requested, give the file a name with a “bmp” extension,
click OK and (when ready) press the PRINT key on the 933A.

6. Within a few seconds the file should transfer. You should see
a number of bytes received. Generally about 9 kB. This time
interval can vary between terminal programs and baud rates.

2.6.1 Tera Term Pro BMP File Transfer

To transfer a bitmap of the display using Tera Term Pro, use the same
steps as in Section 2.6. You should normally select File > Transfer
XMODEM > Receive (as shown below).

1. The next window that appears should be the file Save window.
Type in the name with a bmp extension.

2. Make sure that the two Options CRC and Binary are selected
and click Open.

3. The SaveAs window should disappear and a new download win-
dow should appear, as shown below.

4. Press the PRINT key and you should see values that indicate that
Bytes are being transferred (up to about 9 kB) and disappear.
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2.6.2 Hyper Terminal BMP File Transfer

To transfer a bitmap of the display using Hyper Terminal, use the same
steps as in Section 2.6. You should normally select Transfer > Receive
File (as shown below).

1. When the Receive File window appears, select the location for
the new file capture and choose Xmodem. Now click the Receive
button and type in a file name with a bmp extension.
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2. Press the PRINT button on the 933A and wait for the transfer
process to finish.

3. Normally, it takes at least 20 to 30 seconds for the file to begin
transferring (when you will actually see some bytes changing that
indicate a transfer is taking place).
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Chapter 3

The Setup Menus

3.1 Setup Key

The Model 933A has two main function keys named DISPLAY and
SETUP. Most of the interaction between the user and 933A will begin
with these two keys. From the SETUP key you will be able to configure
all of the 933A functions.

Press the Setup key to control the basic configuration of the 933A.
Using the numeric keys, press the number to the left to configure the
desired function. These are depicted in Figure 3.1.

Figure 3.1: Setup Key Display

35



3.2 Input Setup Menu

To measure accurately with the 933A you must set up the Input Con-
figuration to correctly match the electrical system you are measuring.
The 933A provides six standard choices and also includes a method
for customizing the input. A secondary menu allows you to select the
Frequency Mode, Frequency Reference and Phase Reference.

Figure 3.2: Input
Setup Menu

NOTE: The 933A will compute power and energy qualities when se-
lecting one of these six standard configurations.

3.2.1 Setup Descriptions

1. Press the SETUP key and 0-Input Setup in the Setup Selection
menu.

2. There are two methods to select the input type:

(a) Use the UP/DOWN arrow keys to select the Input Configu-
ration Type and press the Enter key to make the selection.

(b) Using the number keypad, press the number corresponding
to the desired Input Configuration (e.g. 0 - 3Ph4W3E).

3. Press the SAVE SETTING soft key to save the changes and return
to the DISPLAY SELECTION menu.

4. Otherwise, press the NEXT soft key to proceed to the Custom
Input Selection menu.

3.2.2 Configuration Settings Indicator

Note: Input settings appear in the lower right corner of most data
screens, and appear in a small outline of the 933A.
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3.2.3 Custom Input Configuration Selection

Use the Custom Input Configuration menu to customize which Input
signal(s), Frequency Mode, Frequency Reference and Phase Reference
are used for measurement. When choosing Custom & Phase Frequency
References, this screen allows you to individually select the Inputs.

Figure 3.3: Custom
Input Configuration

To select Input Configuration:
NOTE: Normally, this menu is entered from the Input Configuration
menu found on the previous page.

1. Press the Setup key, then Input Setup Menu, then NEXT (soft
key).

2. Use the Arrow and Enter keys to locate and enter the Input sig-
nal(s), Frequency Mode, Frequency Reference, and Phase Refer-
ence.

3. When finished, press the SAVE SETTING soft key, returning you
to the DISPLAY SELECTION menu.

4. Press the BACK soft key if you want to return to the Input
Configuration Menu.

Synchrophasors
To use synchrophasors, you must select Absolute, under Phase Ref.
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3.3 Clock Time Setup Menu

3.3.1 Internal Real-Time Clock

Before making measurements, take time to set up the Real-Time Clock.
Capable of operating in three different modes, each clock mode offers
different performance advantages. Whatever mode you ultimately de-
cide to use, it is important to understand the performance differences,
and to configure the clock so that the clock performance matches your
expectations.

Figure 3.4: Clock Setup

Clock Operating Modes - and Specifications
For a complete list of specifications, please see Chapter 8, entitled
“Specifications.”

Free Running
Time based on the internal oscillator, with no external timing input for
stabilization. Clock time depends on initial setup and has a character-
istic drift over time. Accuracy: Drift less than 1 second per day.

Synchronized to an External IRIG-B signal
Uses an IRIG-B signal from an external clock to synchronize the inter-
nal clock of the 933A. Accuracy: Better than 1 microsecond plus the
accuracy of the IRIG-B source.

Synchronized to an External GPS Signal
Use an accessory GPS module to synchronize the internal clock of the
933A to the GPS time standard. Accuracy: Better than 1 microsecond.
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3.3.2 Clock Setup in Free Running Mode

Note: When manually setting the internal clock on the 933A always
set it to your Local time. Notice that the second line of the display in
Figure 3.4 states, Instrument Time:LOCAL. It is important to set
up the clock in Local Time format. Set up the Local Time as follows:

Procedure

1. Press SETUP, then select 1-Clock Time Set to access the internal
clock setup menus.

2. If necessary press the UP or DOWN key to adjust the Local Offset
to your time zone.

3. Press the NEXT ENTRY soft key and press the UP or DOWN key
to adjust the Daylight Saving Time to your preference: OFF, ON,
Auto USA, Auto EUR, Auto AUSS, Auto AUST, Auto NZEL,
Custom.

4. Press the NEXT ENTRY soft key and enter the year information
from the numeric keypad. The Local Time symbol will appear in
this and the remaining time setting elements (see to the left of
year).

5. Press the NEXT ENTRY soft key and using the UP or DOWN
keys, enter the current month.

6. Press the NEXT ENTRY soft key and adjust the Hour using the
numeric keypad.

7. Press the NEXT ENTRY soft key and adjust the Minutes using
the numeric keypad.

8. Press the SAVE CHANGES soft key before leaving this menu.
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3.3.3 Clock Setup in Synchronized Mode

1. Make sure that you have already set up the internal clock in the
free-running mode. See the previous page for details.

2. Connect the timing signal from an IRIG-B or GPS source.

3. Check your clock settings. Make any changes as required.

Select UTC or Local

1. Make sure that you are in the Clock setup menu. See the previous
page under setting up the clock in Free-Running Mode if you have
not already done so.

2. If you wish to set the internal clock to Local Time, press the
SELECT LOCAL soft key to set the system clock to your local
time zone (Adds the offset in the ZONE menu including any DST
offset).

3. If you wish to set the internal clock to UTC, press the SELECT
UTC soft key.

4. Make sure to press the SAVE SETTINGS soft key before leaving
the clock setup menu.

Notes on Using an External Timing Signal

When connecting an external IRIG-B timing signal, be sure that the
source clock is transmitting UTC. This is because the 933A will add
the Local Offset (including sign) to the time received from the source
clock.

For example, if you are located in the Pacific Time Zone of North
America, the Local Offset would most likely be - 8 hours. If the external
clock is sending local time (i.e. Pacific Time), then the 933A internal
clock will indicate 8 hours earlier than expected.

When using a GPS module, remember that the GPS module always
sends the time as UTC time, so that the 933A Local Offset should be
set according to the normal method.

For example, if you are located in the Eastern Time Zone for the United
States, the Local Offset would be -5 hours.
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3.4 RS-232 Setup Menu

RS-232 port parameters include Baud Rate, Word Length, Stop Bits
and Parity.

Figure 3.5: RS-232Setup

To set up the RS-232 port settings:

1. Press the SETUP key and then choose 2-Serial Setup. To exit,
press the DISPLAY key.

Note: In each of the menus described below for specific port
settings, use the cursor keys and ENTER key to select the desired
setting.

2. Select the Baud Rate and press the Enter key.

3. Select the Length (word length) and press the Enter key.

4. Select the number of Stop Bits and press the Enter key.

5. Select the Parity and press the Enter key.

6. Press the SAVE SETTINGS soft key before leaving this menu, or
any new settings will be lost.
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3.5 Autolog Setup Menu

If you need to automate the tasks of measuring and logging data to the
internal flash memory card, then you may want to configure the Autolog
feature. The purpose is to allow you to begin logging automatically at
a specified time and date, at a chosen rate, and then quit.

Autolog requires a future start time, a recording rate and recording
duration. You can program this feature through the soft keys located
at the bottom of the display.

Figure 3.6: AutologSetup

Example: Let’s suppose you need to record data for about one hour
at 1 minute intervals, starting on December 21st. The starting screen
at the left indicates no date and time, and the AUTO LOG ENABLE
soft key is vacant. The completed configuration is shown on the right
in Figure 3.6 indicates a start time, stop time and a total of 60 records.

To Configure Autolog Operation:

1. Press the SETUP key, then choose 3-AutoLog Setup.

2. Press the AUTO LOG START soft key and set the date and
time by selecting Minutes, Hours, Days/Year when the soft keys
change. When finished with Start, press the Exit Start key.

3. Press the AUTO LOG RATE soft key to select the measurement
interval; select in hours, minutes and seconds. When finished
with Rate, press the EXIT RATE soft key.

4. Press the AUTO LOG DURATION soft key to set the stop time
for the measurement. Duration really means (for the above ex-
ample) How many 1-minute intervals do you want? So, for 60
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minutes, this means 60 intervals. When finished, press the EXIT
DURATION soft key.

5. Press the AUTO LOG ENABLE soft key to arm the Autolog
feature so that the 933A begins measuring when its clock reaches
the Start Time.

3.5.1 Logging Data Indication

When the Autolog start time is reached, the 933A will begin logging
data based on the input signals connected to the 933A and Auto-log
Rate. Auto-log Entries (shown as “0” in Figure 3.6) begin incrementing
with each record stored. AL, appearing within the Status Indicators,
indicates logging activity. Autolog indication is described in Figure 2.9.

Figure 3.7: Review
Log Data

To Access Recorded Data

1. Press the REVIEW key followed by the SHOW LOG soft key.
2. Press the REVIEW SELECTIONS soft key followed by the

SHOW AUTO LOG soft key. This sorts Autolog data from other
logged data.

3. Press the number keypad corresponding to the index number at
the left of the record. This will open the DISPLAY SELEC-
TIONS menu , as if you pressed DISPLAY key. Now, press the
number of the data type you wish to view.

4. Press any other number key to change data types (i.e. that cor-
responds with the Display key).

When viewing recorded data, the instrument is effectively in HOLD
mode and is symbolized by a small magnifier icon among the Status
Indicators. This is shown at the right of the battery symbol in Fig-
ure 2.9.
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3.6 CT/PT Setup Menu

To automatically compensate for CT’s and PT’s (current and poten-
tial transformers), the 933A provides the CT/PT Setup menu to install
these constants. By doing this, the 933A can directly display the pri-
mary current or voltage by converting the actual secondary current or
voltage to the primary value. It does this by multiplying the secondary
current or voltage by the CT/PT ratio and adding the phase difference
to zero reference phase.

In the CT/PT Setup menu, you will find space to enter magnitudes
and phase angles for each configured phase as seen in Figure 3.8.

Figure 3.8: CT/PT
Setup Menu

Setting up CT & PT Values:

1. Press the Setup key and choose 4-CT/PT Setup.

2. Use any of the cursor keys to select the desired value (e.g. A-
PHASE CT RATIO). The rectangle will surround the chosen
value and it will be described in large letters in the lower por-
tion of the display.

3. Use the number keys to enter the CT ratio or phase offset and
press ENTER to install.

4. If the value is nominal for all phases press the APPLY TO A, B
& C soft key.

5. Press the SAVE ALL soft key to save the new CT/PT values.
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3.7 Custom DST Setup Menu

Use the Custom DST (Daylight Saving Time) Setup if you want to
customize the daylight saving changeover feature to one that is not
offered under Clock Time Set. For Clock Time Set, see earlier setup
in this chapter. Features include setting the start and stop date and
time.

Figure 3.9: Custom
DST Setup Menu

To Set up Custom DST

1. Press the Setup key and choose 5-Custom DST Setup.

2. Press the ADJUST START soft key.

3. Press the YEAR soft key and UP/DOWN arrows to adjust the
value for the next occurring.

4. Press the MONTH soft key and UP/DOWN arrow keys to adjust
the starting month.

5. Press the DAY soft key and the UP/DOWN arrow key to adjust
the starting day.

6. Press the HOUR/MINUTE soft key and the UP/DOWN arrow
key to adjust the starting hour and minute.

7. Press the EXIT/ADJUST soft key to return to the previous
menu.

8. Press the ADJUST STOP soft key to adjust the DST ending date
and time. Use the same method as with ADJUST START.

9. Make sure to press the SAVE SETTINGS soft key before leaving
the Custom DST Setup menu. Otherwise, press either EXIT NO
SAVE.
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3.8 Current Setup Menu

Use Current Setup to adjust the current input sensitivity by a factor of
approximately 20. Adjustable settings are either 1 or 20 Amps for each
channel (A, B or C). By switching to 1 Amp, you are increasing the
sensitivity of any one, or all, of the current input channels. Switching to
20 Amps, removes the current input preamplifier thereby reducing the
sensitivity. Note that the ranges change when using the Low Current
Modules (933A-02,03).

Figure 3.10: Current
Setup Menu

Note: Over driving the 933A current input (to greater than 1 Amp)
when configured to the 1 Amp range will not damage the unit, how-
ever it will saturate the input amplifier and may produce unwanted
harmonics.

To Check Current Setup:

1. Press the Setup key and choose 6-Current Setup.
2. View the settings. Choose any of the soft keys to adjust the

current settings.

Soft key Selections

3. Press ALL CHANNELS to change the module setting for all chan-
nels.

4. Press CHANNEL A, CHANNEL B, CHANNEL C individually to
set any of the channels separately or differently than the others.

5. Press SAVE SETTINGS to save any changes made to Current
Module Settings.

6. Press either the DISPLAY or SETTINGS key to leave this menu.

NOTE: The 1-Amp setting has 1% accuracy compared to 0.05% ac-
curacy for the 20 Amp setting.
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3.9 Optional Low Current Modules

Two low-current input modules for the Model 933A are available for
both current-output and voltage-output CTs. Each has two operating
ranges; a high range (up to 1.2 Arms or 2.4 Vrms) and low range (up to
50 mA rms and 100 mV rms) Both modules are identical except for the
input connectors. The 933A-02 is the has two sets of shrouded banana
connectors for each phase, including neutral, including a voltage input
and current input. The 933A-03 has a unique single jack that allows for
voltage and current input signals. Arbiter Systems produces dedicated
cable assemblies (purchased separately) for the Model 933A-03.

Figure 3.11: Low Current Module Setup Menus

3.9.1 Installing

To configure either the 933A-02 or the 933A-03, you will need to replace
the current module already installed in the 933A with the 933-02 or
933-03.

Make sure to power OFF the Model 933A before replacing a current
module.

1. Loosen the hold-down screws using a medium slot screwdriver.

2. Grasp the module and pull it out slowly.

3. Align the new module into the nylon guides and gently slide it
into the slot guides.

4. Tighten the two hold-down screws to secure the module.

5. Start the 933A and press the SETUP key and 6-Current Setup
to check the settings displayed for the module (as seen in Fig-
ure 3.11).
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3.9.2 Configuring

Before using the current module, make sure to press the SETUP key,
then 6−Current Setup to configure the range. You should see the
screen/menu similar to that shown in Figure 3.11.

Notice from the table in screen shot that there are two ranges for current
and two ranges for voltage. The two ranges for current are 50 mA and
1.2 Amp. The two ranges for voltage are 100 mV and 2.4 Volts.

Soft key Selections

1. Make sure to press the MODIFY RANGE soft key to select the
desired current or voltage input range for each phase channel.

2. Next, press the MODIFY INPUT soft key and select either cur-
rent or voltage corresponding to the input type.

3. Before leaving this menu, press the SAVE SETTINGS soft key.
To leave without saving press the EXIT soft key.

3.10 Trigger Setup Menu

The last selection in the setup selection screen is called Trigger Setup.
Trigger Setup allows you to configure the 933A to automatically record
to internal flash specific data when the measured input signal, or cal-
culated DSP value, meets the defined conditions.

The example trigger shown below illustrates the configured fields to
trigger an event when the A-phase voltage exceeds 130 Vrms. For
details on setting up triggers, go to Chapter 7, Triggers and Event
Recording.

Figure 3.12: Trigger
Review Menu
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Chapter 4

The Display Menus

4.1 Display Selection

Press the DISPLAY key to select and view the various types of data.
This includes the active signal(s) connected to the 933A and any data
stored on flash. When using the REVIEW key to view recorded data,
the Display Selection menu is again used to help you select the type of
data. Press the number on the left corresponding to the data type you
wish to view.

When changing between Display selections, just press the correspond-
ing number on the numeric keypad to move through the various dis-
plays.

Figure 4.1: Display Menu
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4.2 Min–Max Setup

Use the Min–Max Setup, within any data display screen, to view the
normal, minimum, maximum and average data values. Restart Min–
Max accumulation from the Min–Max menu.

Figure 4.2: Min–Max
Setup

To select Min / Max / Average or Normal:

1. Press the DISPLAY key and choose 0-Tabular (or other Data
Type selection key) to access the selections from the Min–Max
menu.

2. Press the Min–Max SELECTION soft key to activate the Min–
Max soft menu at the bottom of the display.

3. To view the minimum, maximum or average results, press any
Min–Max function soft key below the display.

4. Press the RESTART Min–Max soft key to reset the minimum,
maximum and average values to zero, and begin storing new val-
ues.

5. Press the EXIT Min–Max to return to the Phase A Results screen.

Note: Remember that the Min–Max function is always active from the
time that the 933A is powered ON. It may be important to press the
RESTART Min–Max if you are starting a new measurement and do
not want any previous measurements (startup conditions, noise, etc.)
included with your new measurement.
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4.3 Tabular Results

Tabular Results include all of the measured electrical values for the
selected phase, including minimum, maximum, average and normal.
The figure below shows A-phase tabular results.

Figure 4.3: Tabular Results

Tabular Results include

� all configured voltage & current phases

� phase angles (Vdeg, Ideg)

� active/reactive/apparent power (Watts, VARs & VA)

� power factor (PF)

� frequency (Hz)

Use the soft keys to select individual phases and total. Use the sep-
arate soft key shown below the display to select Normal, Minimum,
Maximum, or Average, and to Restart values.

Status Indicators also show the internal clock time and date, the cur-
rent instrument configuration and also the charge level of the internal
battery. For definitions of status indicators in the lower part of the
display, see 933A Status Indicators in Section 2.4.12.
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4.4 Harmonic Results

Harmonic Results includes all harmonics from the fundamental to the
50th harmonic for the specific phase voltage and current. Soft keys
allow selection of phase and neutral.

4.4.1 Graphical Harmonics

Select 1−HARMONICS from the Display Selection menu to view
Graphical Harmonics. Soft keys allow you to select each configured
current and voltage. Press the MAGNIFY & TAB KEYS soft key to
switch soft key menus for the magnify and tabular menu.

Figure 4.4: Graphical
Harmonics Display

4.4.2 Tabular Harmonics

Press PREVIOUS 8 HARMONICS or NEXT 8 HARMONICS soft
key to progress through tabular harmonic values. Press GRAPHICAL
HARMONICS soft key to return to the previous display.

Figure 4.5: Tabular
Harmonics Display
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4.5 Waveform Display

Waveform Display indicates the waveforms of rms voltages and currents
for the configured system. Also provides a Magnification function for
better viewing. Display tabular values are amplitudes at the cursor.

Figure 4.6: Waveform
Display

To Display Waveform Results:

1. Press the DISPLAY key and “2-Waveform Display” to view the
waveforms.

2. Press the VOLTAGE WAVEFORMS soft key, CURRENT
WAVEFORMS soft key, or V & A WAVEFORMS soft key to
view the respective waveforms.

3. Press the MAGNIFY ON/OFF soft key to view the magnified
individual waveforms only. New soft keys allow switching between
phases.

Note: This display does not include a complete set of Instrument
Status indicators (lower left of display) when viewing Waveforms.

View Instantaneous Values Waveform Values
Use the right and left cursor keys to move the vertical cursor for better
viewing of peak values.
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4.5.1 Magnify Waveforms

Magnify Waveform Press the MAGNIFY ON/OFF soft key to view a
magnified display of the waveform. Use the right and left cursor keys
to move the vertical line cursor for viewing peak values. Soft keys allow
you to separately view the voltage and current waveforms.

Figure 4.7: Magnified
Waveform Display

Press the Magnify ON/OFF soft key to switch back to viewing the
combined waveform results.

4.6 V & I Tabulation

Press the Display key and select 3-V&I Tabulation, to view all phase
voltages, currents and neutral current. Select the Min–Max SELEC-
TION soft key to switch between Normal / Minimum / Maximum /
Average Results, and to Restart the counting for these results. For ad-
ditional information on Min–Max selection, see Min–Max Setup earlier
in this chapter.

Figure 4.8: Voltage &
Current Tabulation
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4.6.1 Show Sequence

Press the Show Sequence soft key to replace the Neutral reading with
any sequence voltages or currents.

4.6.2 Show Ratio

Press the Show Ratio soft key to display the ratios of Va to Vc, Va to
Ia and Ia to Ib. These measured components are fixed and no other
ratios are available. Also, the data is only available on the display of
the 933A, not available through the normal data stream from the 933A
using PSCSV.

Figure 4.9: Show Ratio
Display

4.6.3 Show Impedance

Press the Show Impedance soft key to switch from voltage and cur-
rent to impedance - resistance (R) and reactance (X). Indicates the
impedance of all configured phases and sequence components.

Figure 4.10: Show Im-
pedance Display
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4.7 Power Tabulation Display

Displays the Active, Reactive, Apparent and Q Results, as well as
Power Factor, of power measurements for the configured system. Min–
Max Results changes the soft keys to allow access to Normal, Minimum,
Maximum and Average Results.

Figure 4.11: Power Tabular Display

Press the EXIT Min–Max soft key to exit the Min–Max RESULTS
menu and return to the Power Tabulation main menu.

4.7.1 Power Calculations

Power and Energy are determined by making twenty separate measure-
ments per second with each measurement using 1024 samples (i.e. it
takes data from a 100 millisecond window). This yields a 50% overlap
for all readings to preserve accuracy. Therefore, since power is aver-
aged over the interval, the displayed value may not exactly match what
you would compute by multiplying the currents and voltages for each
second.

For more detailed information on power calculations, see Appendix A:
Model 933A Functional Description.
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4.8 Power Quality

Displays two types of flicker; Instantaneous (One Second) and PST
(10 minute). One-second flicker is displayed every second and PST
continually indicates a 10 minute count-down timer with the result of
the calculation in the same display. Press indicated soft key to switch
between 1–Second and PST. Press Min–Max soft key to view minimum,
maximum, average and normal values.

Figure 4.12: Show Power
Quality

To select power quality:
1. Press the DISPLAY key and choose 5–Power Quality to select

the One–Second Flicker results.
2. Press the Min–Max SELECTION soft key to open the NORMAL

/ MINIMUM / MAXIMUM / AVERAGE / RESTART of the
power quality results.

3. Press RESTART Min–Max to restart tabulating power quality
readings.

4.8.1 Min–Max

Press the Min–Max SELECTION soft key to open the Min–Max selec-
tion menu. For more information on using the Min–Max function, see
page 50.

Figure 4.13: Min–Max Control
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4.8.2 Flicker Information

Flicker measurements deal with a fluctuation of the line voltage. It is
a very specific problem related to human perception and incandescent
light bulbs, but not a general term for voltage variations.

The basic concept behind placing limits on voltage fluctuations is that
they cause lights to flicker, which can be irritating and may cause dis-
comfort. Voltage fluctuations are caused by loads on the power distri-
bution system, which are located near lighting equipment (within the
same building or powered by the same distribution transformer), and
have changing power or current levels.

Based on groups of people tested for irritation from light fluctuations,
most tend to be irritated when the light fluctuates at around 1000
changes/minute. Apparently above 1800 changes/minute light flicker
is no longer perceived. Fluctuations in the rms voltage of only 0.25%
are sufficient to cause noticeable flicker in light bulbs.

The 933A measures flicker according to IEC 61000–4–15.

Definitions

Voltage Fluctuation: a series of voltage changes or a continuous
variation of the rms voltage.

Flicker: Impression of unsteadiness of visual sensation induced by a
light stimulus whose luminance or spectral distribution fluctuates with
time.

One Second Flicker (or Instantaneous): is defined as the flicker
measurement that is updated each second. The Model 933A displays
this measurement.

Short-term flicker indicator, Pst: The flicker severity evaluated
over a short period (10 minutes); Pst = 1.0 is the conventional threshold
of irritability. A reasonable goal might be to limit Pst values to less than
1.0 for 95% of the time. The Model 933A displays this measurement.

Long-term flicker indicator, Plt: The flicker severity evaluated
over a long period (over 2 hours) using successive Pst values. The Plt
threshold is 0.8. The Model 933A does not display this measurement.
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4.9 Energy Tabulation

Energy Tabulation makes all energy-related parameters accessible from
one screen. This includes Watt-hours, VAR-hours, VA-hours, Q-hours
and energy restart function (soft key on the far right).

Figure 4.14: Energy Tabular Display

To select Energy Tabulations:

1. Press the DISPLAY key and choose 6–Energy Tabulation.

2. Press the specific soft key to view Wh, VAh, Qh and VARh RE-
SULTS.

Energy Restart Press the ENERGY RESTART soft key to reset the
energy totals to zero.
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4.10 Phasor Display

Displays the voltage and current phasors for the configured system
measured by the 933A. Screen includes tabular and vector data, soft
keys for viewing the voltage phasors, current phasors or both. Display
also includes instrument data including time, date and battery charge
level.

Synchrophasors (using Absolute Phase Reference) will rotate as fre-
quency differs from nominal. The selected phase reference will appear
in the 0 position, horizontal to the right.

To select Phasor Displays:

1. Press the DISPLAY key and choose 7–Phasor Display soft key to
view the phasor display.

2. Press the VOLTAGE PHASORS soft key to view the graphical
and tabulated results of the voltage phasors.

3. Press the CURRENT PHASORS soft key to view the graphical
and tabulated results of the current phasors.

4. Press the V & C PHASORS soft key to view the graphical and
tabulated results of the voltage and current phasors.

5. Press the Log key to record any data to flash memory.

Figure 4.15: Phasor Dis-
play
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4.11 Basic Data List

Basic Data List includes lists of all phase voltages, currents, power
and energy-related data, including totals. Refinements include Energy
Delivered, Basic plus Quality, Basic plus Sequence, Basic plus Phase
and Min–Max Selection.

To select basic data list items:

1. Press DISPLAY and choose Basic Data List.

2. Press any of the soft keys to choose the desired results with Basic
Data. See screens below for individual information.

Figure 4.16: Basic Data Display
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4.12 Config & Status

Press 9–CONFIG & STATUS to view configured electrical system, com-
munication, time and date, calibration information, firmware versions
by date. Also included is a Battery and Flash Status screen that breaks
down each category in more detail: Battery Status, Main Flash, Log
Flash, Event Flash and DSP Flash. See screen shots below.

Figure 4.17: Config and
Status Display
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4.12.1 Status with GPS Synchronization

When selecting 9 − Config & Status with GPS connected for clock
synchronization, a soft-key named SHOW GPS STATUS will appear.
Press the SHOW GPS STATUS soft key to view GPS status informa-
tion. Press the SHOW GPS STATUS soft key to display geographical
position and satellite tracking information. Press the SHOW SATEL-
LITES soft key to display the satellite positions and relative signal
strength information.

Figure 4.18: GPS Status
Display
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Chapter 5

Reviewing 933A Data

Review event and data records stored in the Model 933A by pressing
the REVIEW key and selecting the type of records you want to review.
The REVIEW key main screen is shown below.

Figure 5.1: Initial Main Review Screen

5.1 Review Data Selections

The following choices are available by pressing the appropriate soft key
from the menu above:
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5.1.1 Show Log Data

Show Log data refers to the 1-second data that is logged during a LOG
key press, an Auto Log function, or from a Trigger (DSP, Sag Swell, or
from the optional Auxiliary I/O Module).

5.1.2 Show User Event Data

Show User event data refers to the event record, including the exact
time and date of the User programmed event, not the data that may
be stored before, during and after the event.

5.1.3 Show Sag Swell Data

SHOW SAG SWELL data refers to the event record, including the
exact time and date of the Sag Swell event, not the data that may be
stored before, during and after the event.

5.1.4 Erase Log Data

Press the ERASE LOG DATA soft key to clear all the data from the
flash memory card.
The following pages describe, in short steps and in more detail, how to
view and download data from the 933A.

5.2 Steps to Review Records

Listed below are steps to assist you with identifying and locating the
specific data you want to review. Basically, there are two types of
records stored in the 933A: data records and event records.

5.3 Locating Records

Decide which type of data you wish to view; a record of the event, or
the data recorded during the event?

5.3.1 Locating the Data Logged During an Event

To find actual data measured by the 933A, proceed as follows:

1. Press the keys, REVIEW > SHOW LOG > REVIEW SELEC-
TIONS
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2. Press the appropriate soft key that indicates the source of the
data - Event Logs, Key Logs, Auto Logs or All Logs.

3. You can reduce or increase the rate at which you can search
through records by pressing the REDUCE RATE or INCREASE
RATE soft keys.

4. Press the numeric key that corresponds to the data record you
wish to review.

5. Press the numeric key corresponding to the data type from the
DISPLAY SELECTIONS screen to view the actual data record.
Press any other numeric key to change the data type.

5.3.2 Locating Event Records

To find the event record information in the 933A, proceed as follows:

1. Press the keys, REVIEW > SHOW USER, or SHOW SAG
SWELL

2. Press the REDUCE RATE or INCREASE RATE soft keys if
necessary.

3. Press the numeric key that corresponds to the event record you
wish to review. Notice that the event record always indicates the
trigger by number and whether it is active (up arrow) or inactive
(down arrow).

4. The next screen will always show the high-speed waveform record
of the event, and within 50 ms of the event. Remember that there
should be either 25 or 30 cycles of pre-event data.

5.3.3 Reviewing Recorded Data (Show Log)

To view any recorded data (following an Event or LOG key press, or
Autolog session) press the keys:

REVIEW > SHOW LOG > REVIEW SELECTIONS > (EVENT
LOGS, KEY LOGS, AUTO LOGS or ALL LOGS)

Press the soft key corresponding to the type of data you wish to review.
This does two things: (1) it opens the specific data record selection
window, and (2) returns you to the previous menu. From here you
can review a record, choose other record types to review, press the
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REDUCE RATE or INCREASE RATE soft keys to improve record
searches.

Figure 5.2 below shows how the 933A sorts the data records according
to type. If you choose SHOW EVENT LOGS, only the Event records
would show up in the list. The “T” symbol on the right side of the
individual record indicates that the data record is from a trigger.

Figure 5.2: Notice that
11 records show up in the
list. “A” indicates
Autologs, “K” indicates
Key Logs and “T”
indicates Trigger Logs.
Compare the time and
date of record number 0
with the time and date of
Figure 5.4.

Pressing the REVIEW key > REVIEW SELECTIONS soft key and
then one of the Show Log soft keys causes the Display Selection screen
to appear. This allows you to choose the type of recorded data for
viewing. Press the cursor or a numeric key to produce the DISPLAY
SELECTION screen in Figure 5.3 below. Next, press the numeric key
corresponding to the desired data type.

Figure 5.3: Review
Display Selection;
appears the same as
pressing the DISPLAY
key, but during review it
is in Hold Mode.

Press any of the number keys on the keypad to select the desired data
type. Remember that the 933A stores a complete 1-second record of
all measured data. The date and time of the data record in the list
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should agree with the date and time of the actual data record shown
here.

Figure 5.4: Phasor
Record Review; compare
the time and date with
Figure 5.2 record 0.

5.3.4 Review Selections Soft Key

Press the REVIEW SELECTIONS soft key to select the type of logged
data you wish to view - Event Logs, Key Logs or Auto Logs.

� Show Event Logs - reveals only the recorded data from an event.

� Show Key Logs - reveals only the recorded data from a LOG key
press.

� Show Auto Logs - reveals only the recorded data from an Auto
Log.

� Show All Logs - reveals all three types of logged data.

� Exit Selections - returns to the previous screen (e.g. Review Se-
lections).

Reduce Rate / Increase Rate

Use the REDUCE RATE or INCREASE RATE soft keys to adjust the
scanning rate through the stored records. RATE keys will save time
searching when the 933A has hundreds or thousands of records. The
933A indicates the search rate just above the soft key labels at the
bottom of the display.
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5.4 Reviewing User Event Data

In general, records are stored chronologically with the latest record at
the top of the list. When viewing event records held in flash memory,
the instrument is placed in Hold Mode, and you may access all recorded
event data from the keypad. The User Event Record screen is described
below.

Press REVIEW > SHOW User EVENT (soft key) to view the event
records.

5.4.1 Interpreting a User Event Record

The data line in the small window (shown in the figure below) indicates
an event record. The values and symbols in the record indicate some
things about the event.

� The event number, on the left of the display, includes the se-
quential number (0 - 9), the trigger number (01) and the arrow
symbol. The arrow symbol signifies if the trigger is either active
or inactive. An up arrow indicates an active trigger and a down
arrow indicates an inactive trigger.

� Date & Time − date and time that the event occurred, including
fractional seconds (in 50 ms increments).

� Type − Indicates the type of event record, User or Sag Swell.

Figure 5.5: Review All Logged Records
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5.4.2 Searching for Records

Use the soft keys and cursor keys to page and scroll through the records
list. This is very useful when there are hundreds or thousands of
records.

Current Record Number

The current record is shown in the small window entitled Log Item:
nnn..., where nnn... is the current record number. Press the right or
left cursor arrows to step through the records. The vertical line in
the window between Oldest and Newest indicates the position of the
current record relative to the total number of records.

Total Log Items

The number of Total Log Items indicates the total number of records
in the Log file. Flash storage capacity is approximately 16,000 records.

Reduce Rate / Increase Rate

If the total number of records is very large, press the rate adjust soft
keys then to speed up the location of individual records.

To change the review rate, press the REDUCE RATE or INCREASE
RATE soft key. The rate changes as follows: One Entry per Step, One
Percent Steps, Five Percent Steps, Ten Percent Steps, Twenty Percent
Steps.

The Record Number Indicator (vertical line) gives a visual clue to where
the current list of records lies within the entire list of stored data.

To Return to Measurement Mode

To go immediately to the Measurement Mode from Hold Mode (while
reviewing triggered data), press the HOLD key twice. The 933A will
again begin displaying current measured data on the display.

To Review Recorded Data Again

Press the REVIEW key again to start over.
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5.4.3 Viewing Recorded Data at the Time of Event

Note that when viewing event records, the 933A will immediately reveal
the high-speed waveform data record at the time of the event. However,
no other records are available from this menu. To view data records,
you must select REVIEW > SHOW LOG > REVIEW SELECTIONS
to view other data. See Figure 5.6.

Figure 5.6: Reviewing Records

1. Press REVIEW > SHOW LOG > REVIEW SELECTIONS >
SHOW EVENT LOGS to open a list of event-triggered data
records stored in flash memory. Up to eleven of the most recent
records will appear.

2. Use the Enter key, or one of the numeric keys, to view the any
data recorded at the time of the selected User event. The Display
Selections screen will appear as seen below.

3. To view other types of data, simply press the numeric key that
corresponds to the data type in the DISPLAY SELECTIONS
menu.

Figure 5.7: Selecting Records
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5.4.4 Reviewing Sag Swell Event Data

The 933A treats Sag Swell event records in much the same way as User
Event Data Records, only revealing the waveform at the sag or swell
when you press any of the numeric keys corresponding to the event
record number.

Note that when you press the ENTER key (see Figure 5.8), the 933A
will reveal the high-speed waveform data recorded at the time of the
event. No other records are available from this menu.

Figure 5.8: Selecting and Viewing Sag Swell Records

1. Press the REVIEW key and select the SHOW SAG SWELL soft
key. A list of any sag-swell event records will appear in the display
if the 933A has captured any.

2. Press the ENTER key to view the waveform record at the time of
the event, or any numeric key corresponding to the record number
in the list.

Notice that each data record provides a record number, trigger number,
date and time of event, max and min values attained while the trigger
was active.

Viewing Sag Swell Data Records

To view any data recorded at the time of the Sag Swell event, you must
choose it by selecting (from REVIEW and associated soft keys):

REVIEW > SHOW LOG > REVIEW SELECTIONS > SHOW
EVENT LOGS
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5.5 Reviewing Data using PSCSV

In order to review 933A data using PSCSV software, you must first
make a connection to the 933A. For information on making a connec-
tion, go to Chapter 6, PSCSV Basics.

To review data recorded in flash triggered by an event, click the Down-
load Event button and a small window should appear with the following
data types:

� DSP Log - all User event records.
� Per Second - all one-second data recorded due to an event
� Sag Swell - all Sag Swell (Power Quality) Event records.
� Waveform - waveform data recorded due to a sag swell event

Event Selection List Window

For each data type, a window will appear that allows you to select the
type of data for saving and viewing. These are shown in Figure 5.9.

Figure 5.9: Download Event Screen - PSCSV 933

Record Selection

The screenshot shown in Figure 5.10 allows you to choose either to
Select All records or Select Range. Select Range allows you to limit
the number of records you want to view by date and time.

Figure 5.10: Selecting Events to Download − PSCSV 933
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5.5.1 User Event Record Example

Outlined in the procedure below, is an example of downloading User
Event records. Select USB for downloading waveform data, otherwise
the download time could be very lengthy.

Figure 5.11: Downloading User Records with Progress

Downloading Procedure

Make sure that you are connected to the 933A. If not, see Chapter 6,
PSCSV Basics.

1. Begin by clicking the Download Event button to open the
“Choose Event . . . ” type data window − see Figure 5.9. Select
the “DSP Log” radio button, and click OK.

2. From the Data Selection window, choose either Select All or Select
Range data by date and time − see Figure 5.10. If choosing Select
Range, date and time values are in UTC format.

3. A SaveAs window should appear that allows you to save a record
of the download. Click the Save button and the records should
be transferred from the 933A to the computer.

4. When the User Log window appears, a progress window will in-
dicate the progress of the record download graphically and by
number of records − see Figure 5.11.

5. When the download is complete, select the line that indicates 933
DSP Log with your cursor and click once. The previous window
should immediately be minimized and a second SaveAs window
should appear.
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6. Click Save, or choose another filename and click Save, and a new
data record window should appear as seen in Figure 5.12.

Figure 5.12: Viewing Triggered Event Records − these are not the data
records, but the time and date that the event occurred.

5.5.2 Per Second Data

Per–Second Data are the actual data recorded during an event. Click
the Download Event button or select Connection > Flash > Download
Event.

1. Choose the Per Second radio button and click the OK button.

2. Choose to select all data records or a smaller selection by time
and date and click the OK button.

3. Choose a file name and click the OK button to save the file
log. During this time a window will appear that shows both
the progress and the record files being transferred from the 933A
to a file on your computer.

Figure 5.13: Downloading Per–Second Data
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4. Now select the top line in the log with your cursor and a Save-As
window will appear . Type in a name, click the OK button and
a window will appear with the data.

Figure 5.14: Downloaded Per–Second Spreadsheet Data

Notice that the spreadsheet of data types are organized by the tabs at
the bottom of the window and fills to the right.

The data window above contains normal one-second data including
voltages, power, frequency and flicker. Select minimum and maximum
values from the tabs below.

5.5.3 Sag Swell Data

Make sure that you are connected to the 933A. If not, see Chapter 6,
PSCSV Basics. Click the Download Event button or select Connection
> Flash > Download Event.

1. Choose the Sag Swell Event radio button and click the OK but-
ton.

2. Choose to select all data records or a smaller selection by time
and date and click the OK button.

3. Choose a file name and click the OK button to save the file log.
During this time a window will appear that indicates both the
progress and the record files being transferred from the 933A to
a file on your computer.

4. Now select the top line in the log with your cursor and a Save-As
window will appear. Type in a name (or accept the suggested file
name), click the OK button and a window will appear with the
data.
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Figure 5.15: Downloaded Sag–Swell Event Data

Figure 5.16: Downloaded Sag–Swell Data

5. Notice that each record begins with the time and date, followed
by the trigger number, followed by a description of the event and
finally the maximum and minimum values attained during the
time the trigger was active.

5.5.4 Waveform Data

Recorded waveform data may be the result of User or Sag Swell Triggers
Events. Make sure that you are connected to the 933A. If not, see
Chapter 6, PSCSV Basics. Click the Download Event button or select
Connection > Flash > Download Event.

1. Choose the Waveform radio button and click the OK button.

2. Choose to select all data records or a smaller selection by time
and date and click the OK button.

3. Choose a file name and click the OK button to save the file log.
During this time a window will appear that indicates both the
progress and the record files being transferred from the 933A to
a file on your computer.
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4. Now select the top line in the log with your cursor and a Save-As
window will appear. Type in a name, click the OK button and a
window will appear with the data.

5. Notice that each record begins with the time and date, followed
by the trigger number, followed by a description of the event and
finally the maximum and minimum values attained during the
time the trigger was active.

Figure 5.17: Downloaded Waveform Data

PSCSV933 provides trigger information the bottom of the waveform
display, whether the trigger is active or inactive during the waveform
recording. For example, if the triggering condition is false the display
will indicate, ”No triggers active”. If a specific trigger is active, then it
will indicate a message with the trigger number; for example if Trigger
number two is active while the recording is going on, it will say, ”User
Triggers Active: 2”. If more than one trigger is active, then all of them
will be listed.
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Chapter 6

PSCSV Basics

6.1 Introduction

This chapter was written to help you become familiar with PSCSV for
the 933, the application software that accompanies the Model 933A.

6.1.1 Linking

The first step in successfully operating the 933A using PSCSV is by
linking the 933A to a computer running PSCSV. To link them:

� connect the proper cable between the computer and the 933A

� open a connection to the 933A using PSCSV software

Prior to operation, however, determine what type of connection you
need to configure. The 933A provides two connection options: RS-
232C and USB 1.1. See page 18 for port identification.

Since the 933A was designed as a portable instrument, most of the fea-
tures may be configured from the keys on the front panel. There are
some features that are more easily configured from PSCSV, and pro-
vide the user additional flexibility. One valuable function when using
PSCSV is the capability of managing data and downloading records for
analysis.
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6.1.2 PSCSV Features

The 933A system consolidates many features that make it ideal for
tracking and recording faults in an electrical power system.

� Analyze Power Quality: Harmonics, Flicker, K-factor and Inter-
ruptions

� Capture Events from 32 Configurable Triggers

� Log Data from Triggers

� Autolog based on Time and Date

� Synchronize with GPS or IRIG-B for Phasor Measurement

� Optional Event Inputs and Relay Contacts

6.2 Menu Systems

The PSCSV main screen provides access to its many features by as-
sembling them together according to functional groups called Menus,
Toolbars, Function Buttons and Windows.

TIP: When you first start PSCSV, only a few icons in the program
will be available, but PSCSV will NOT be linked (having an open serial
connection) to a specific Power Sentinel. You must click the Connection
button or select Connection > Open to initiate a serial connection.

One function that is available when PSCSV is not linked to a Power
Sentinel is viewing a data file(s). You can open Data files using the
Open button without being connected to a 933A.

6.2.1 Main Window

Switching Toolbars ON or OFF

To switch Toolbars on or off depending on the need and available space,
select ‘View’ on the Main menu.

Moving and Viewing Features

You can move any Toolbar and dock it around the Main window by
selecting and holding one of the Toolbar handles and dragging the
Toolbar to a preferred location.
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Figure 6.1: Main PSCSV–933 Screen

6.2.2 Toolbar and Button Definitions

Main Toolbar

Figure 6.2: Main Toolbar

Open: opens a specific 933A file (saved to a computer running PSCSV)
− has browse features

Export CSV: exports selected 933A file records to .CSV for use in
spreadsheet programs. Select either current data, or from data files.

Create a Snapshot: saves a sample of currently broadcast data to a
separate file.

Copy: copies selected records in a file under review in the PSCSV
main window.

Home page: connects you to the PSCSV home page at:

www.arbiter.com/pscsv/index.php.
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Connection Toolbar

Figure 6.3: Connection Toolbar

Open a Connection: allows users to select a connection type, specify
parameters and open a connection between the 933A and computer.

Close a Connection: immediately closes the current open connection
(shown in the Connection Window) between the 933A and a computer.

User Login: PSCSV has a User Login feature (Key symbol) that is
available for certain Arbiter products. The Model 933A does not use
the Login feature. All features are available with an open connection.

Connection Window: indicates the open connection between the
933A and computer (See drop-down window in Connection Toolbar).

Broadcast Toolbar

Figure 6.4: Broadcast Toolbar

Stop All: stops all broadcast data streaming from the 933A.

Stop This: stops the current broadcast data and leaves others alone.

Pause: pauses the flow of data from the 933A into the PSCSV data
window. Broadcast data accumulates while paused.

Basic Data: initiates the flow of Basic Data into the Main window.

Energy Data: initiates the flow of Energy Data into the Main window.

Harmonic Data: initiates the flow of Harmonic Data into the Main
window.

Harmonic Summary Data: initiates the flow of Harmonic Summary
Data into the Main window.
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Waveform Data: initiates the flow of Waveform Data into the Main
window.

Phasor Data: initiates the flow of Phasor Data into the Main window.
Indicated as PMU-1.

Flash Toolbar

Figure 6.5: Flash Toolbar

Flash Status: opens the flash memory status summary.

Erase Flash: erases all records held in flash memory.

Download Events: opens the Download Event window. Selects
records for downloading from flash memory.

Erase Events: not used in the Model 933A.

Input Toolbar

Figure 6.6: Input Toolbar

Channel A Voltage: channel voltage input buttons turn ON or OFF
the specific signal when Broadcast waveform or phasor data are present.
Same for B or C phases.

Channel A Current: channel current input buttons turn ON or OFF
the specific signal when Broadcast waveform or phasor data are present.
Same for B and C phases.

Increase Vertical Scale: increases vertical scale resolution when
viewing phasor data from Frequency Plot tab.

Decrease Vertical Scale: decreases vertical scale resolution when
viewing phasor data from Frequency Plot tab.
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Records Toolbar

Figure 6.7: Records Toolbar

Use the Records Toolbar to page through the data, especially when
there are a large number of records.

View Menu

Use the View menu to control the appearance of data streaming from
the Model 933A. Items that can be controlled are described below.

� Time Format - allows the time format accompanying data in ei-
ther Local or UTC

� Data Filters - controls the data being viewed on the screen.

� Waveform Smoothing - smooths the waveform appearance caused
by the limited number of data points used to construct waveform
data.

� Time Interval - changes the time scale for waveform and phasor
data - similar to an oscilloscope - to expand or compress the
horizontal scale. Certain values are only available under preset
viewing conditions.

� Auto Scale - Used by some functions to automatically scale data
to fit in the window size.

� View As - allows you to view most data in real time or spread-
sheet, harmonics also as vertical bars and phasors as a vector or
frequency plot.

� Toolbars - allows you to switch on or off any combination of
toolbars.
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6.2.3 Edit Menu

Copy: copies the selected data to the clipboard.

Select All: selects all of the data in the Data window.

Preferences: selects window for setting various time and date viewing
preferences. Select colors of signals in Waveform and Phasor views.
Click the Edit menu to open.

Figure 6.8: Edit Menu, Preferences

Connection Options with the 933A

You have two serial port options available for linking the 933A to a
computer.

� RS-232C

� USB 1.1

These two communication ports are useful for remotely configuring the
933A, and also for downloading the stored data to a computer. You
can link the 933A to a computer by (1) connecting the correct cable
between the 933A and the computer, and (2) opening a connection
from PSCSV.
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6.2.4 Connecting with the 933A

RS-232 Port

To open a connection between the 933A and a computer (refer to Fig-
ure 6.9:

1. Connect the included RS-232 cable (phone cord) and adapter
(RJ-11 to DB-9) between the 933A and the computer.

2. Press SETUP > 2 − Serial Setup on the 933A to verify the com-
munication port settings (especially Baud Rate).

3. Start PSCSV and click the Open a Connection button in PSCSV,
or choose Connection > Open.

4. Click the plus sign, next to RS-232, to reveal the COM selections,
which refer to the computer serial port. Choose the desired com
port and check to see if the port settings agree with that on the
933A.

5. Click OK and nine of ten buttons on the Broadcast Toolbar
should become active. This shows that there is an RS-232 con-
nection between the 933A and computer.

6. At this point, you have access to the instrument for downloading
data or configuring the 933A. Go to the appropriate sections to
perform these actions (e.g. see Section 6.3).

Figure 6.9: Connection Window
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USB Port

1. Connect the included USB cable between the 1133A USB port
and the computer USB port.

2. Start PSCSV and click the Open Connection button or select
Connection > Open.

3. Select the plus sign (+) next to USB Devices, select USB 933 and
click OK. The main window should indicate a USB connection
name in the connection window and all of the icons should now
be active.

Figure 6.10: Connection Window, USB Selected

6.2.5 Configuring the 933A

Use PSCSV to remotely configure the various features of the Model
933A and accessory equipment. You can configure most features from
front panel or all features by using PSCSV software.

Configuring Ports

Available settings in the Configure Ports menu include Communica-
tion Port 1, DNP and C37.118 PMU-1. All of the other items in the
Configure Ports menu are not available.

RS-232, Communication Port 1

Remember to use the USB port if you are going to configure Com-
munication Port 1 settings. Otherwise, you will most likely lose your
connection. For example, if you connect to Communications Port 1 at
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38400 baud and change the baud rate to something else, then you will
lose communications. You will have to disconnect and reconnect at the
new baud rate.

The available settings are Baud Rate, Data Bits, Stop Bits and Parity.

Figure 6.11: Configure RS–232 Port

PMU-1

When dealing with phasor data, PSCSV is both a configuration and
data acquisition tool. It is designed to configure the 933A to pro-
duce C37.118-type data. This means that while data is very similar to
C37.118, the 933A does not have an Ethernet port and is not C37.118
compliant.

Phasor Terminology

Active means that PMU-1 is poised and ready to send data − set to
ON if you want it to be active. Set to OFF if you want it to be inactive
(or unresponsive). PMU-2 and PMU-3 are not available in the 933A.
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Figure 6.12: Configure Phasors, PMU–1

Station (or STN) is the station name, in 16 bytes in ASCII for-
mat, given to the PMU. This field helps to identify the location of the
equipment.

ID (or IDCODE) is the 16-bit integer, assigned by the user that
uniquely identifies the device sending and receiving messages (like the
933A). No two devices can have the same ID on the same network.

Header contains additional information on any subject concerning the
PMU, of 64 bytes in ASCII format. Type in the information and press
the Enter key. This field could be used to identify the type of equip-
ment.

Input allows you to select the type of signals you want to include
in the C37.118 report or broadcast. This includes all phase voltages
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and currents, Positive Sequence, Negative Sequence, Zero Sequence
components and Digital DSP Triggers. Turn them ON or OFF.

Analog allows you to select all of the power-related parameters (Watts,
VARs, and VA) that you wish to view and turn them either ON or OFF.

Window Length sets the integer number of measurements averaged
for stability; if you choose 1 for example, the values will update more
quickly, however appear less stable; values range from 1 to 24.

Estimated Rate, Hz is the integer number of phasor samples per
second. Rate values are different for 50 Hz and 60 Hz.

Cycles Used is a calculated value based on multiplying the Estimated
Rate (R) times the number of cycles (or Window Length, W) times the
Number of Channels (N). Cycles = R x W x N. For example in the
screen shot from the previous page, this value is 20 x 1 x 6 = 120,
where N equals three voltage and three current channels. Maximum
values are 6000 for 60 Hz and 5000 for 50 Hz.

Data Format allows you to set up the computation resolution and
speed of which the 1133A processor can send data

Nominal Frequency Choose either 50 Hz or 60 Hz nominal.

Adaptive Tuning is used to help eliminate the possibility of losing the
signal due to filter rolloff effects by continuously adjusting the receiver
center frequency. Adaptive tuning is disabled if the error exceeds the
limit. Set to ±2, ±5 or ±10 Hz.

Estimator Algorithm The 933A offers a wide range of window func-
tions. All window functions serve the same purpose (as a low-pass
filter) and work in the same manner. The main difference between
windows is the magnitude of the ‘sideband lobes,’ which are peaks in
the rejection band. Select a window function (Estimator Algorithm)
based on desired performance. Test algorithm performance using Win-
dowFunction.exe, the free software tool available on the Arbiter web
site. See http://www.arbiter.com/software/downloads.php

Digital Channels The 933A allows you to select any of the 32 available
User (DSP) triggers records to accompany the regular phasor data.
Select to report in either the normal or triggered state.
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6.2.6 Configuring Measurement Parameters

Configure several measurement options by selecting Connection > Con-
figure > Measurement Parameters or by clicking the Measurement Pa-
rameters button. You are not able to set “Internal Calibration,” and
“Voltage Linearity” from PSCSV.

DSP Mode

DSP Mode includes setting the system frequency, input configuration,
voltage range, current range, current auto range and enabling Anticreep
as seen in Figure 6.13.

Figure 6.13: Configure Measurement Parameters, DSP Mode

CTPT Ratios and Constants

CTPT includes setting CT and PT nominal ratios, and twelve points
for magnitude and phase error, and the calibration point for each. This
is seen in Figure 6.14.

Figure 6.14: Configure Measurement Parameters, CT/PT Values
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Loss Compensation

Loss Compensation allows you to compensate for the iron and copper
losses (real and imaginary) when connecting through a transformer as
seen in Figure 6.15. Compensate for transformer loss only through
PSCSV, not through 933A front panel.

Figure 6.15: Configure Measurement Parameters, Loss Compensation

Anticreep

Anticreep sets an threshold below which the 1133A will not accumulate
energy in the specific registers. This is similar to restricting an older
style (electromechanical) meter from spinning when the energy value
was below a certain threshold. Older electromechanical meters would
spin due to the fact that they were merely energized and energy was not
consumed by the user. Configure Anticreep in the “Configure DSP”
panel in PSCSV only, not from the front panel. Anticreep units are
measured in volt-amps.
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6.2.7 Other Windows

Save As
Any time you are opening one of the broadcast data items, it will open
with a Save As window. Since the data that you are broadcasting is
ending up on your computer (monitoring the 933A measurements), it
needs a file name. The SaveAs window suggests a suitable file name.
You can choose this one, or you can type in another, and click OK.

Limit File Size
So that the data file does not take unlimited memory on your computer,
the window allows you to specify how much data you want to collect
before overwriting previously stored data. At the bottom of the Save
As window is a check box with an associated size in megabytes.

Filter Data Tool
Select View > Filter Data to configure the types of data that will
appear in any of the Broadcast Data screens. Filtering applies to both
Summary and Spreadsheet views. Filtering only limits what is being
displayed in PSCSV, not what is saved in the file.

Figure 6.16: Data Filter Tool

One-Second Data
Many of the Broadcast Data items (like voltage, current and frequency)
are averaged values over a one second interval, providing more accurate
measurements. For details on how the 933A computes these values,
please see Appendix A, Functional Description.
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6.3 Broadcast Data Categories

6.3.1 Basic Data

Basic Data includes all of the configured input signals (voltages and
currents - magnitude and phase), sequence components, frequency
and frequency-related quantities, power-related quantities, and flicker.
These values are computed as one-second data and a fresh measurement
appears on the screen each second. Broadcast data can be synchronized
to the GPS or IRIG-B and simultaneously saved in a file of choice.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums
and maximums. Fields include the named parameters, using the Filter
Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local),
dates and one-second, measured parameters as filtered using the Filter
Data tool.
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6.3.2 Energy Data

Energy Data includes all energy-related qualities, including Watt-
hours, Volt-Amp-hours, VAR-hours and Q-hours These values are com-
puted as one-second data and a fresh measurement appears on the
screen each second.

To limit the number of items on the screen, use the Filter Data tool,
which allows you to select only the items of interest. Note that filtering
does not limit what is being stored in the data file; it only limits what
is being displayed.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums
and maximums. Fields include the named parameters, using the Filter
Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local),
dates and one-second, measured parameters as filtered using the Filter
Data tool.
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6.3.3 Harmonic Data

Harmonic Data includes all harmonic voltages and currents, magnitude
and phase, from the fundamental to the fiftieth harmonic; thats 200
values for each phase. These values are computed as one-second data
and a fresh measurement appears on the screen each second.

To limit the number of items on the screen, use the Filter Data tool,
which allows you to select only the items of interest. Note that filtering
does not limit what is being stored in the data file; it only limits what
is being displayed.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums
and maximums. Fields include the named parameters, using the Filter
Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local),
dates and one-second, measured parameters as filtered using the Filter
Data tool.

Harmonic Bars includes a graphical comparison of the various har-
monic currents and voltages including the fundamental.
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6.3.4 Harmonic Summary Data

Harmonic Summary Data includes RMS THD, RMS K, THD F, THD
T and K Factor for all of the configured voltages and currents. All
harmonic summary values are delivered to the open window.

Summary Data Screen

Summary view presents a graph in real time over a one-minute interval
with the beginning and ending measurements and overall minimums
and maximums. Fields include the named parameters, using the Filter
Data tool.

Spreadsheet Data Screen

In spreadsheet format, tabular data includes times (UTC and Local),
dates and one-second, measured parameters as filtered using the Filter
Data tool.
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6.3.5 Waveform Data

Waveform Data includes a number of cycles of all configured phase
voltages and currents. Control the number of complete cycles using
the View > Time Interval window control and choose a time interval
value (from 50 ms to 5 seconds). A cursor allows you to pick out
instantaneous voltages or currents.

To control the number of items on the screen, use the Input toolbar,
which allows you to select only the voltage or current of interest. Note
that filtering does not limit what is being stored in the data file; it only
limits what is being displayed.

Waveform Data Screen

Graphical view displays current and voltage waveform data within a
small time interval that is somewhat adjustable. Use the Input Toolbar
to select only the voltage or current of interest.

Waveform samples are at 600 per second or approximately 10 per cycle
at 60 Hz.
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6.3.6 Phasor Data

Phasor Data includes all configured phase voltages and currents, fre-
quency, sequence and energy values. Data log times are also indicated
in the display.

To control the number of items on the screen, use the Input toolbar,
which allows you to select the voltage(s) or current(s) of interest. Note
that filtering does not limit what is being stored in the data file; it only
limits what is being displayed.

Displays

There are two phasor views that include a phasor with tabular data
view and a frequency plot view. In the phasor data view, you can
select to display the desired phase voltages or currents, and expand to
view some tabular data.
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6.3.7 Lists of Broadcast Values

Data values available when selecting Basic Data from the Broadcast
Toolbar are listed below.

Basic Data − 55 Values
1. A, B and C phase voltages and currents − magnitude and phase

angle
2. Positive, Negative and Zero Sequence Voltages and Currents −

magnitude and phase angle.
3. Active Power (Watts) for A, B, C phases and Total.
4. Apparent Power (VA) for A, B, C phases and Total.
5. Reactive Power (VAR) for A, B, C phases and Total.
6. Power Factor (PF) for A, B, C phases and Total.
7. Q for A, B, C phases and Total.
8. System Frequency (Hz)
9. System Frequency Deviation

10. System Frequency Rate (df/dt)
11. System Time Deviation, Seconds
12. System Time Deviation, Cycles

Energy Data − 40 Values
1. Watt-Hours, Delivered and Received: A, B, C phases and Total
2. VAR-Hours, Q1 − Q4, A, B, C phases and Total
3. VA-Hours, Delivered and Received: A, B, C phases and Total.
4. Q-Hours, Delivered and Received: A, B, C phases and Total.

Harmonics, Fundamental to the 50th − 600 Values
1. Voltage: A, B and C phases − magnitude and phase angle.
2. Current: A, B and C phases − magnitude and phase angle.

Harmonic Summary − 6 Values
Includes RMS THD, RMS K, THD F, THD T and K-Factor for voltage
and current.

Waveform Data − 6 Values
Includes 3 phases for voltage and current.

Phasor Data − 6 Values
Includes 3 phases for voltage and current.
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6.4 Data Conversions

6.4.1 Exporting COMTRADE Files

These instructions cover the exportation of COMTRADE files gener-
ated from waveform data captured by the Model 933A. During the
exportation process, two COMTRADE files, a .dat and a .cfg file, are
generated from waveform file and saved on the host pc.

Running Power Sentinel CSV 933 Software, the opened waveform data
is converted directly into these two files. The method used to capture
waveform data in these instructions is by setting a voltage trigger to
create a waveform record. The Model 933A automatically creates a
waveform record when a configured 933A trigger becomes active (when
the required event occurs). The specific trigger configured in these
instructions initiates recording when the phase voltage dips below a
limit, and the 933A begins recording data to flash memory. This wave-
form record is then downloaded to the host pc. Once stored on the
pc, the record is easily converted into two COMTRADE files. Without
a captured waveform file there will be no information to convert to
COMTRADE.

Basic Steps Required

1. Set up triggers in the 933A (on front panel or PSCSV).*

2. Connect signal wires.*

3. Erase previous logged data.

4. Instigate or wait for an event.

5. Download waveform data.

6. Export COMTRADE Files.

*Note: Order of these steps may be changed according to type of test-
ing performed. For complete instructions on setting up a trigger, see
Chapter 7.

Power Sentinel CSV Software version 1.109, dated 2 August 2007, was
used in creating these instructions.
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6.4.2 Exporting to CSV Format

While you are reviewing any data downloaded from the 933A, you may
choose to convert it to CSV format and review it on your spreadsheet.

In the session below, Per Second data is viewed after being downloaded.
Notice that there should be a CSV button, also accessible by selecting
File > Export CSV.

When you select either, a Save As window should appear with a sug-
gested file name. Either click the OK button or type in a new file name
and click OK.

Figure 6.17: Downloaded One–Second Data

A second window should appear and ask if you want to open your
spreadsheet application with the data loaded. You can choose either
Yes or No. If you select Yes, then the data converted to CSV format
should appear in the spreadsheet (similar to that shown below).

Figure 6.18: Converted Data to Excel Format

Note that the “Export CSV” feature works on any data that has been
downloaded or broadcasted from the 933A. Any data that has been
broadcasted after you save the converted data will not appear in the
file. If you want to include any later data in the same file, simply go
through the Export CSV procedure again.
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6.4.3 Exporting to PQDIF Format

While you are reviewing any data downloaded from the 933A, you may
choose to convert it to PQDIF format.

In the session below, Figure 6.19 illustrates Per Second data being
viewed after being downloaded. Export the selected data by selecting
File > Export PQDIF.

A Save As window should appear with a suggested file name. Either
click the OK button or type in a new file name and click OK.

Figure 6.19: Downloaded One–Second Data

Note that the “Export PQDIF” feature works on any broadcast data
(except waveform or phasor) that has been downloaded or broadcasted
from the 933A. Any data that has been broadcasted after you save
the converted data will not appear in the file. If you want to include
any later data in the same file, simply go through the Export CSV
procedure again.

6.4.4 Save As Snapshot

Save As Snapshot creates a separate data file of all of the data recorded
during a normal broadcast session up to the time that you create the
snapshot file. Broadcast data will continue to fill the original broadcast
data file. If you decide to create a later snapshot, the file will have all
of the original data but with added data records determined by the
interval number of seconds between the two snapshots created.
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Chapter 7

Triggers and Event
Recording

7.1 Introduction

In this section we will look at how the Model 933A uses triggers to
record data and how to configure these triggers from the 933A front
panel. For reviewing triggered events and logged data, see Chapter 5,
Reviewing 933A Data.

7.1.1 Recording Data to 933A Flash Memory

When an event occurs that activates a trigger, the 933A will store
a record of the event and begin recording all of the available DSP
parameters into flash memory based on the times configured under the
LOGGING TIME screen.

Available Recording Methods

� pressing the LOG key see LOG key in Basic Operation.

� using the Autolog feature see Autolog in The Setup Menu

� configuring User Triggers

� configuring Sag-Swell Triggers

� using the External I/O Module see External I/O Module later
in this chapter.
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7.1.2 User Triggers

User Triggers are configured to signal the Model 933A to record data
based on parameters measured and and then processed by the Model
933A DSP. There are a total of 32 different triggers available that you
can assign as either a User or Sag Swell trigger.

7.1.3 Sag–Swell Triggers

While Sag Swell Triggers are set up in a manner very similar to User
Triggers, and are part of the pool of 32 triggers, they are different than
User Triggers and are covered later in this chapter. Sag Swell triggers
conform specifically to IEC 61000-4-30, section 5.4, Supply Voltage
Dips and Swells.

Cursor Key Selection: Generally, use the up/down cursor keys to
select the Trigger category and the right/left cursor keys to change the
category value.

7.2 Setting a User Trigger

Follow the procedure in this section to configure a User trigger from the
front panel. Remember that whenever you select a User trigger number,
it is removed from the pool of 32 available triggers until turned off or
reconfigured.

7.2.1 New Trigger

1. From any screen, press the SETUP key, then select 7- Trigger
Setup from the number keypad. You should see a screen similar
to that shown in Figure 1.

Figure 7.1: Initial Trigger
Setup
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2. Using the left/right cursor keys, choose a Trigger number (1 −
32); using the up/down cursor keys move the cursor to SELECT
MODE, then use the left/right cursor keys to choose User. Press
the ENTER key to open a screen entitled EDIT User TRIGGER
(by number).

Figure 7.2: Selecting a
User Trigger Mode

Definitions for the User Trigger values are found on the following
pages.

3. Choose the triggering parameters in this screen. Definitions for
these parameters are found on the next page. Use a combination
of the cursor keys, enter and numeric keys to enter the data.
Normally, you will not need to press the Enter key each time you
select a new configuration item. Press the up or down arrow to
move to another field.

Figure 7.3: Selecting
User Trigger Values
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7.2.2 Logging Time

4. Press the LOGGING TIME soft key to define the time period
to log data when a trigger becomes active. There are two values
to set: MaxLogTime and PostFault. MaxLogTime defines the
number of seconds to record data after the specific trigger be-
comes active (i.e. faulted). PostFault time defines the number of
seconds that the 933A continues to record data after the trigger
becomes inactive (i.e. after the fault has disappeared).

Figure 7.4: Installing
Data Logging Times

7.2.3 Back Soft key

5. Press the BACK soft key to return to the specific trigger setup
menu and view any of the trigger settings by trigger number.

Figure 7.5: User Trigger
View
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7.2.4 SAVE SETTINGS Soft Key

6. Press the SAVE SETTINGS soft key to store the trigger changes.
You may do this after setting up a number of triggers. Without
pressing the Save Settings key, you will lose any configuration
settings that you just made. It is always possible to return to
TRIGGER SETUP to configure additional triggers as needed.

Dependency and Master Triggers

For more complicated triggering, where you would like to capture an
event that depends on the occurrence of another event, use the De-
pendency option. For example, suppose that you wish to see the how
frequency deviation is related to voltage sags. You could set up a fre-
quency trigger that looks for a frequency deviation outside of a specified
range. However, before you will allow the trigger, you must set up the
dependency to another trigger that watches for a voltage sag. In this
example, the voltage trigger would be called the Master, and the fre-
quency trigger would be the dependent trigger.

Master triggers are subdivided into two groups: ActiveMaster and In-
activeMaster. For Active Master, a dependent trigger could become
active only after the master trigger became active. Conversely, for
Inactive Master, a dependent trigger could become active when the
Master trigger became inactive.

Dependency may also be set up in PSCSV software. For details on
setting up DSP Triggers and Dependency, see Section 7.6.

Edit User Trigger # − Category Screen

Choose a value for each category where applicable. Generally, you can
select each category using the up/down cursor keys and select a value
in that category using the right/left cursor keys.

7.2.5 User Trigger Parameter Definitions

Input Signal: Voltage, Current, Watts, VARS, VA, Power Factor
(PF), Seq V Comp, Seq I Comp, Ph Bal Ratio, Freq & Time, THD
Voltage, THD Current, Harmonic Vrms, Harmonic Irms, K-Factor V,
K-Factor I, Flicker, Inst V, Flicker, Pst V, Flicker Inst I, Flicker, Pst
I, Reserved(0 − 4), SchulzLaiosCh(1 − 6)

Channel: Select the phase of input signal, noted as A, C, B and Ave.
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Limit Type: These are the logical conditions used to trigger; x >
limit, x < limit, |x| > limit, |x−ref | > limit, where x is the measured
signal.

Limit: a numerical value (floating point) to which x (the input signal)
is compared.

Reference: Sets a numerical value (floating point) used with the Limit
Type |x− ref | > limit for the value of ‘ref’. Can be used in a window
comparison.

Dependency: Sets this specific trigger as a Master Trigger. Values are
Off, ActiveMaster, InactiveMaster; “Off” turns off the Master Trigger
feature; use the other two values to set up this trigger as a Master
Trigger.

Master Trig: Assigns the specific Trigger number (1 − 32) as the
Master Trigger, and upon which the current trigger is dependent. The
Master Trigger must be set up prior to the dependent trigger to be
available.

Dwell Time: Defines a period in seconds during which the trigger-
ing condition is true before it switches to Active. If set to zero, the
triggering is instantaneous.

TriggerLog: ON or OFF; OFF means that when a trigger occurs,
no event data will be recorded, but one-second data will be recorded,
ON means that when a trigger occurs, an event record and data will be
recorded. MaxLogTime: Sets the maximum time in seconds for logging
data after the trigger condition is Active − from 0 to 65535 seconds.

PostFault: Sets the time in seconds that the 933A will log data after
the triggering condition has disappeared and that trigger has become
Inactive − counts from 0 to 65535.
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7.3 Setting a Sag–Swell Trigger

Follow the procedure in this section to configure a Sag Swell trigger.
Remember that whenever you configure any trigger number (User or
Sag-Swell), it is removed from the pool of 32 available triggers until
turned off or reconfigured.

7.3.1 New Trigger

1. From any screen, press the SETUP key, then select 7- Trigger
Setup from the number keypad. You should see a screen similar
to that shown below. Using the left/right cursor keys, choose a
Trigger number.

Figure 7.6: Sag Swell
Trigger Selection

2. Using the up/down cursor keys move the cursor to SELECT
MODE, then use the left/right cursor keys to choose SAG
SWELL and press the Enter key.

Figure 7.7: Selecting Sag
Swell Parameters

3. You should see a screen entitled EDIT SS TRIGGER (by num-
ber). This is the screen in which you configure most of your Sag
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Swell settings. After you are finished with all of the settings in
this screen, press the LOGGING TIME soft key on the left to set
the how long you want the 933A to log one-second data.

Edit Sag Swell Trigger No. − Category Screen

Choose a value for each category where applicable. Generally, you can
select each category using the up/down cursor keys and select a value
in that category using the left/right cursor keys. Numerical values (e.g.
Limit) are entered directly from the numeric keypad.

7.3.2 Sag Swell Trigger Parameter Definitions

Channel: AV, AI, CV, CI, BV, BI, NI - includes all of the input
voltages and currents, including Neutral. Set the Channel value to the
input signal you want to compare to the Limit.

Limit Type: x > Limit, x < Limit; the first indicates a measured
value greater than the limit, and the second indicates a measured value
less than the limit.

Limit: Floating point value; constantly being compared to the input
Channel value (x) in order to capture an event trigger. For example,
Limit = 130 and x > Limit would mean that a trigger would occur if
the measured input voltage became greater than 130 Vrms (i.e. x >
130).

Limit Fmt: (Limit Format) Absolute or Percent; choose the limit
format that suits your application. For Absolute, the limit is the same
number as the value entered in for Limit. For example, a Limit of 130
could generate an event trigger if the voltage swings above 130 Volts.
For Percent, the measured value is compared to a percentage of the
measured signal. Ten percent above nominal would be entered as 1.1.

Ref Fmt: (Reference Format) Absolute or Sliding; when using a ref-
erence value, choose either Absolute or Sliding. Absolute means that
the reference value is fixed and compared directly. Sliding means that
Reference value is not fixed (or absolute) and can change slowly, such
as with a gradually rising or dropping voltage. See page 116.

Hysteresis: Floating point value; reduces extraneous records from
accumulating when a measured value is wavering around a limit or
reference.
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Hysteresis Format: Absolute or Percent; Absolute refers to a fixed
value for hysteresis, and Percent refers to a percentage of the measured
value. As the measured value increases or decreases, so the hysteresis
will change according to the given percentage of hysteresis.

Multiphase: B, C, BC or OFF; means that the Trigger parameters
will also apply to B phase, C phase or both B and C phase, without
defining another trigger.

Hysteresis

Hysteresis allows the user to set up some triggering conditions to re-
duce the tendency of a wavering signal (e.g. voltage) from generating
unnecessary triggers. Figure 7.8 illustrates a voltage wavering around
about 130 Vrms, which is the set Limit for a trigger. To avoid un-
wanted triggers occurring at points A, B, C and D, a hysteresis value
of 2 was chosen. This prevents a trigger from occurring unless the volt-
age drops at least 2 volts below the Trigger Limit. For the trigger to
again become Active (i.e. after point E), Va would need to again cross
the 130-Vrms Limit.

Figure 7.8: Example of Hysteresis

Sag Swell Reference

For Sags Swells Triggers, install the Sag Swell Reference value, for each
required channel, in a separate display screen shown below. In this
case, Reference refers to an initial, numerical voltage/current value,
which is preloaded into the register for Sliding Reference voltages.

Press SETUP > 7 − Triggers > Sag Swell Reference soft key as seen
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below. Install the values for any required reference. Press BACK to
return to the Trigger menu.

Sliding Reference

Set the Reference Format to Sliding when you want to follow daily
variations in voltage or current that do not require a trigger unless
exceeding some expected value. For example, if due to usage require-
ments the line voltage sags during the day and swells during the night,
you might want to use a sliding reference to avoid unnecessary triggers.
A sliding reference would only generate a trigger only if the voltage
unexpectedly sags or swells at a rate greater than expected.

Calculating a Sliding Reference Voltage

Per the specification IEC61000-4-30, the sliding reference voltage is
calculated by using equation 7.1; it is of first-order and uses a one-
minute time constant.

(7.1) Usr(n) = 0.9967× Usr(n−1) + 0.0033× U(10/12)rms

Where

Usr(n) is the present value of the sliding reference voltage;

Usr(n−1) is the previous value of the sliding reference voltage; and

U(10/12) is the most recent 10/12-cycle r.m.s. value.

Note that even though the specification defines the input signal (U) as
a voltage, it has been applied to the 933A to include measured input
currents, as calculated using the same formula, with U as a current.

Logging Time

There are two available settings of which you can choose to control
how the 933A logs one-second data when a trigger becomes active:
MaxLogTime, and PostFault.

MaxLogTime determines how long the 933A will log data after a
trigger becomes active. Setting MaxLogTime to 10 seconds will cause
the 933A to record 10 per-second records after a trigger becomes active.

PostFault determines how long the 933A will record data records to
flash after the specific trigger becomes inactive.
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Remember that if you have several triggers armed, any of them may
be responsible for the 933A logging data if they become active.

7.4 Event Waveform Capture

7.4.1 Capture Method and Features

The Model 933A samples each of the six measurement channels at
10,240 samples per second at 16 bit resolution, and begins sampling
when triggered from a specified event. Event recording always begins
with one-half second of prefault data, so that you will always capture
conditions in the 25 or 30 cycles of waveform data preceding the fault.

To capture this data the 933A has 128 MB of flash memory that is
devoted entirely to waveform storage, and should be able to store suffi-
cient data to analyze all channels. Thus, depending on the application,
the 933A is able to capture inrush currents, sags and swells, transients
and many other non-periodic phenomena.

7.4.2 Triggering High Speed Data Capture

The 933A begins recording data (including high-speed waveform) when-
ever a specified event trigger occurs. To assure that you capture the
waveform anomalies you want, make sure to carefully configure the
triggering conditions in the 933A.

Figure 7.9: Reviewing Captured Waveforms

When a specified event happens, the 933A will begin recording data in
both flash modules for the time specified in LOGGING TIME setup
screen. There are three items to configure in this screen: (1) Trigger
number, (2) Maximum Logging Time, and (3) Post Fault Time. Re-
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member that the 933A always provides you with one-half second (or 30
cycles at 60 Hz) of prefault waveform data recording.

7.4.3 How Much Data do I Record?

It takes about 18 minutes to fill up 128 MB of waveform flash with
the six input channels - three voltages and three currents. Decide how
much data you really need to record following an event. A few seconds
of data is should be ample for each record, however the 128 MB allows
for additional event recordings, providing the postfault data is kept
short. For example, if each record includes one half second of prefault
data and one second of post fault data (90 cycles), the 933A could
provide approximately 720 fault records.

When selecting one of the event records by number, use the numeric
keypad or enter key. The 933A will immediately open the waveform
view at the time of the event and allow you to scroll forward and back-
ward with the cursor keys to inspect the waveform. Use the right and
left cursor keys to locate and examine specific points on the waveforms.
Instantaneous values are computed where the cursor and the waveforms
intersect and tabulated at the bottom of the screen.

Press the COMPRESS WAVEFORMS or EXPAND WAVEFORMS
soft keys to view more or less of the captured event waveforms.

7.4.4 Event Capture Example

The waveform screen shown below is an example of an event caught
through setting a Sag Swell trigger on C-phase voltage. The voltage
limit was set for 85 Volts rms, and trigger with x < Limit. The 933A
also caught a one-half second of the prefault waveform data, which is
about 30 cycles.

By using the Expand or Compress soft keys and the right and left
cursor keys you can review specific points of the event chronologically.

Note: The 933A records complete sets of one-second data around the
occurrence of the event, depending on the set Logging Times. The 933A
stores the main data records in the standard flash module, and stores
high-speed waveform in another 128 MB flash module used exclusively
for that purpose.
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Figure 7.10: Captured
Event Waveform

Viewing One–Second Log Data

1. Press REVIEW > SHOW LOG (soft key) to view a complete list
of one-second log data. See Figure 7.11.

2. Press the REVIEW SELECTIONS soft key to separate all of the
one-second log data into groups, and press the SHOW EVENT
LOGS soft key

3. Look through the one-second data to find the time of occurrence
of the event and press any of the number keys to select a data
point.

Figure 7.11: Captured
One–Second Record

4. Press any of the number keys to select the data type for viewing
(e.g. 0-Tabular Results).

5. Press any of the soft key selections to choose to view any config-
ured phase, or to view Min/Max information.
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Erasing Captured Waveform Data

To erase any records stored in flash, press the REVIEW key, followed
by the ERASE LOG soft key. You will be asked if you really want to
erase all of the stored data in the flash memory modules. Select either
the NO or YES soft key to proceed.

7.5 Auxiliary I/O Module

Triggering with the Auxiliary I/O Module is very straightforward and
is easy to set up. See Page 11 for accessory information.

7.5.1 Auxiliary I/O Module Description

The Auxiliary I/O Module has three contact outputs and four event
inputs. One of the output contacts is a solid state set (KYZ-rated) and
the other two are standard Form C mechanical contacts. The Event
Inputs are separated into three groups: one set rated at between 24
to 240 Vdc, one set rated at TTL-level voltages (5 Vdc), and two sets
are contact closure. Signals are connected to the module with ring
terminals and connection to the Model 933A is by a nine-foot cable
assembly.

The Auxiliary I/O Module is powered from the Model 933A and must
be installed with the Model 933A powered off.

7.5.2 Configuring Event Inputs

1. Open the Auxiliary I/O connector cover on the 933A and slide in
the plug on the end of the cable into the connector until it snaps
in position.

2. Power on the 933A.

3. Press the SETUP key > 7 − Trigger Setup.

4. Press the EVENT SETTINGS soft key and choose the Event
Input number with the right/left cursor keys.

5. Select the Mode (depends on the Event Input number), Max Log-
ging Time (MaxLogTime) and Post Fault Time (PostFault).

6. Press the BACK soft key, and remember to Save Settings.
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Figure 7.12: Event Input
Setup, Active

Terminology

In the Event Input Setup Window of the 933A are several terms:
EventInput, Mode, MaxLogTime and PostFault.

EventInputs: 1 − 4

Mode; configures which input state triggers the 933A to begin record-
ing; Active Hi or Active Lo.

MaxLogTime: time the 933A will log data while the triggering con-
ditions are active (i.e. that the triggering conditions are true).

PostFault: time the 933A will log data after the triggering conditions
are inactive (i.e. the fault conditions are no longer true).

Checking the Event Inputs

To verify the event inputs, you can apply a correct voltage to event
inputs 1 or 2, or use a short length of wire to short across the contacts
of event inputs 3 or 4.

1. Press the SETUP key and 7 − Trigger Setup.

2. Press the Event Settings soft key to view the event screen (see
Figure 7.13).

3. Connect the triggering signal to the desired event connection.

4. Watch the value in the line that states EVENT INPUT STATE
change from 0 to 1 when the event occurs.

5. You can also watch the events stack up by pressing the Review
key > Show Log. For each new event, you will see a number of
records recorded based on the specified logging time.
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Figure 7.13: Event Input
Setup, Inactive

7.5.3 Configuring Relays

The Auxiliary I/O Module has three relays; one solid state (KYZ)
and two mechanical, Form C contacts. Relays 2 and 3 are useful for
signaling by change of state from any one of 32 triggers.

Figure 7.14: Relay Setup

Relay 1, KYZ-Rated Contacts

Relay 1 is a set of solid state contacts useful for keeping track of energy
using the KYZ method. To set up these contacts, refer to Figure 7.14.

1. Select SETUP (key) > 7 - Trigger Setup > RELAY SETTINGS
(soft key).

2. Specify the channel (A, B, C or Total), the type of signal (e.g.
Watt-hour), and the scale (see below under Kp Register Scale
Factor).
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Kp Register Scale Factor

Correct scaling is necessary for accurate KYZ pulse metering. Enter
in the value using the numerical keys on the front of the Model 933A
keypad. Scale factors are expressed in basic units (e.g. Watt Hours per
Pulse) and should be set up not to exceed 20 pulses per second, the
limit of the 933A. To arrive at the minimum scale factor value so not to
exceed this threshold, take the maximum value of the basic unit being
measured and divide by 72,000. This should give you the absolute limit
(minimum value) for a scale factor.

For example, if the maximum input value (including CT-PT ratios)
is 240 kWh, then the minimum scale factor for Watt Hours should
be greater than 3.3333333 (240, 000 ÷ 72, 000 = 3.333 . . .). The value
produced is the Scale Factor (e.g. 3.3333 Wh per pulse). Scale Factors
will be directly proportional to the value measured. Therefore, the
greater the measured value, the greater will be the minimum Scale
Factor.

Over-Range Condition: An over range input condition will exceed
the 20/second output capability of the 933A, causing KYZ pulses to
stabilize at that rate. If this is the case, for momentary periods, the
accumulator in the 933A will store these counts not degrade the Model
933A accuracy. If data has accumulated in the 933A, then when the
signal has dropped below 100% (by Scale Factor) the output will put
out the additional pulses until the accumulated overage equals zero.

Relays 2 and 3, Mechanical Contacts

Relays 2 and 3 are two separate mechanical contact sets and each have
a limited lifetime of about 100,000 cycles. Contacts are designed to
change state based on the configured Trigger for each relay. For exam-
ple, Relay 2, in the Figure 7.14, is set to trigger based on the state of
Trigger 2. When the trigger limit condition is exceeded, then the trig-
ger is considered Active and the relay will change state. When Trigger
2 changes back to the previous state, then the relay will revert to its
previous state. Relay 3 is identical to Relay 2 and can be set up in the
same manner as Relay 2.

As seen in Figure 7.15, Trigger 2 is responsible for activating Relay 2
when A-phase voltage drops below 85.0 Vrms. Notice that a hystere-
sis value of 0.5 was used to reduce the chatter from a signal on the
measured channel fluctuating above and below the limit value.
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Figure 7.15: Relay-
Trigger Reference

7.5.4 General Relay Setup Procedure

1. Set up the Trigger (either User or Sag Swell ) on the 933A or by
using PSCSV software.

2. Set up the desired relay by specifying the trigger in step 1, as
seen in the RELAY SETUP screen in Figure 7.14.

7.6 Configuring with PSCSV Software

Use PSCSV for the 933 to configure both DSP and Sag Swell Triggers.
Configure both DSP and Sag Swell triggers from the same location:
Configure Trigger Parameters.

1. Make sure that you have a connection between the Model 933A
and your computer. For RS-232 connections see page 88, and for
USB connections see page 89.

2. Open the window by clicking the Configure Trigger Parameters
button, or by selecting Connection > Configure > Trigger Para-
meters.

3. Once the Configure Triggers window is open, select the type of
trigger you want to use; either User or Power Quality (Sag Swell).

4. Go through each trigger parameter, selecting any item that best
defines what you are measuring.

5. See Sections 7.2.5 and 7.3.2 for definitions of the various cate-
gories in the User Triggers and Power Quality Triggers configu-
ration panel.
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7.6.1 User Triggers

1. Select Users Triggers in the left panel of the Configure Triggers
window.

2. Select an unused trigger (by number) by choosing the drop-down
arrow under the column named “Input Signal” and adjacent to
the desired trigger.

3. Begin choosing and filling in parameter values. Note that not
all parameter fields are required (e.g. Reference & Dependency).
See Page 111 for details.

7.6.2 Sag Swell Triggers

1. Click the Power Quality Triggers label in the left panel of the
Configure Triggers window.

2. Select an unused trigger (by number) by choosing the drop-down
arrow under the column named Input Signal and adjacent to the
desired trigger. Input Signal value will indicate OFF if it is not
selected.

3. Begin choosing and filling in parameter values. Note that all fields
are required for Power Quality Triggers. See Page 114 for details.
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Chapter 8

Specifications

8.1 Introduction

AC voltage and current input connectors allow for connecting to most
common electrical systems. All other values − such as power and en-
ergy − are derived from these measurements and the internal clock. An
optional GPS module or IRIG-B signal may synchronize the internal
clock. Possible input configurations and ranges are specified below.

8.2 Input Configurations

3 Phase (3P) 3-element, 2 1/2-element, 2-element

1 Phase (1P) 2-element, 1 1/2-element, 1-element

Input Voltage

Range (3P/1P) 0 − 650 Vrms, maximum − selectable (phase-to-
phase for 2 element, phase-to-neutral for 2 1/2
and 3 element).

Over Range 700 Vrms, nominal

Input Current

Range (3P/1P) 20 Arms, maximum - per element

Over Range 23.5 Arms, nominal (maximum continuous input
current: 20 Arms per element).
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Volt-Amps, Watts, Volt-Amps-Reactance

Range Product of rated voltage and current ranges and
number of elements.

Compensating Constants and Ratios

CT and PT Nominal ratios, magnitude and phase compen-
sation, CT uses quadratic spline curve model.

Transformer Both iron and copper compensation.

Input Frequency Range

Range 45 − 65 Hz, for specified accuracy.

Harmonics 3 kHz

Input Connector Ratings

Connections Shrouded Banana, colored per phase

Insulation 400 Volts, nominal, to neutral/chassis, surge
voltage class III

600 Volts, nominal, to neutral/chassis, surge
voltage class II

8.3 Instrument Interface

Front Panel Indicators and Controls

Keyboard 30 keys, for status and configuration; including
5 soft function, 7 dedicated function, 5 cursor
control, power on/off and 12-button numeric key
pad

Display Graphical LCD − 3 x 3.9 inches, 240 x 320 dpi,
backlighted

Communications

Serial RS-232C, RJ-11 modular connector

USB Version 1.1, B-Type receptacle

128



Protocols

Proprietary PowerSentinelCSV (PSCSV)

Supported DNP 3.0, MODBUS, PQDIF, MV-90 (pending)

Flash Memory Data Storage

Capacity 128 MB x 2, standard; 2 separate flash cards

One used for 1-second data

One used for waveform

Data Selectable from all functions measured and total-
ized by 933A; each record is stored with a time
tag

Storage Rate Selectable

Event data stored upon occurrence

Lifetime 100,000 cycles

Data Retention Indefinite; no power or battery required to retain
data

DSP Configuration

Configure Using PSCSV, configure DSP Mode, CT-PT ra-
tios and transformer loss compensation. Internal
calibration set at factory.

Unit Type Texas Instruments, TMS320C32 Floating-Point
DSP

Configuration (Default) 120 V, 5 A, 60 Hz, 3-phase / 4-wire
/ 3-element; Other system configurations made
through the front panel or PSCSV software.

Mode All structures initialized to know default settings
(calibration values done after initialization).

129



8.4 Optional Auxiliary I/O Module

Programmable Contacts

Type 2 each, Form C (SPDT)

1 each, Solid State (KYZ rated)

Connections screw terminal

Rating 250 Vac/125 Vdc, 8 A maximum, 2000 VA/150
W maximum

Isolation 4000 Vrms for 1 minute to chassis

Contact output connection is made through the Auxiliary connector on
the front panel.

Event Input Connections

Type and
Number

Four, optically-isolated; one at 24 to 240 Vdc,
one 5 V logic level, and two contact closure

Isolation 4000 Vrms for 1 minute to chassis

Resolution 1 µs

Event input connections are made through the Auxiliary connector on
the front panel of the Model 933A.

8.5 System Control and Monitoring

System Time, Phase and Frequency

System Time Unlimited accumulation with ±1µs resolution

Frequency 7 digits, xx.xxxxx Hz

System Phase 0 to 360◦ with 0.01 resolution

8.6 Synchronization

Optional IRIG-B Unmodulated Input

TTL-Level Shift per IEEE 1344 as output from any Arbiter Systems
clock model.
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Optional Remote GPS

Tracking GPS-L1 (1575.42 MHz)

12 channel (tracks up to 12 satellites)

Acquisition 2 minutes typical

Accuracy UTC-USNO ±1µs (only 1 satellite with
correct position needed)

Out-of-Lock
Indication

Via system interface and status display;
optional, via contact closure.

Timebase Error

GPS locked Less than ±1µs, when locked to at least one
satellite with correct position

Unlocked 10 PPM, typical, after being locked to
10 minutes minimum (< 1 second/day unlocked,
typical)

IRIG-B Less than 1µs + accuracy of IRIG-B source

8.7 Measurement Specifications

NOTE: Accuracy specifications include all sources of uncertainty. Ex-
cept as noted, specifications apply for the full operating range, includ-
ing temperature (-10◦ to +50◦ C), line voltage, input range including
specified over-range, power factor, input frequency, and drifts over a
one-year calibration interval. Specifications assume synchronization to
GPS and operation in 3-element mode or in a well-balanced system
where imbalance does not degrade accuracy.
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Accuracy

Watts, Wh 0.05% of reading, for voltage 7 to 650 Vrms and
current 10 mA to 20 Arms and PF > 0.2

Under range 0.005% multiplied by (10 mA/I rms) for current
< 10 mA rms, typical

Vrms 0.05% of reading1 or 0.002% range, whichever is
greater

Arms 0.05% of reading1 or 0.003% range, whichever is
greater

V2h 0.1% of reading1 or 0.004% range, whichever is
greater

A2h 0.1% of reading1 or 0.004% range, whichever is
greater

Phase Angle, φ 0.01◦, phase-to-phase or voltage-to-current1

Under range 0.05◦ (current 10 to 50 mA rms)

VA, VAh 0.05% of reading1

0.1% (current 10 to 50 mA rms)

VAR, VARh Same as W, Wh except replace PF with
(1− PF 2)0.5

Power Factor 0.0002× sin(φ)1

0.001× sin(φ) (current 10 to 50 mA rms)

Harmonics 0.1% THD or 5% of reading, whichever is greater

Frequency < 1 ppm (0.0001%) of reading, 50 or 60 Hz nom-
inal, plus timebase error

System Phase 0.03◦plus[timebaseerror × 360◦ × frequency]2

System Time 1 µs plus timebase error2

Event Inputs ±10µs (typical)

1. For voltage 50 to 650 Vrms and current 50 mA to 20 Arms.
2. With GPS option.

Phasors

Standard Per IEEE Standard 1344 or PSCSV

Rate 20 Measurements/second
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8.8 General

Physical

Size 205 x 305 x 225 mm (8 x 12 x 8.75 in.)

Weight 5.8 kg (12.8 lbs), maximum

Environment

Temperature -10◦ to + 50◦ C, Operating

-40◦ to +75◦ C, Nonoperating

Humidity Non-condensing

8.9 Power Requirements

Internal Battery

Type NiMH

Operation 8 hours, typical

Charging 4 hours

Standby Use 5 VA, typical

External Power

Range 85 to 264 Vac, 47 to 63 Hz or 120 to 275 Vdc, 25
VA typical 5 VA typical stand by use

Input IEC connector with fuse; surge withstand per
ANSI C37-90.1 and IEC801-4 standard
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Chapter 9

Functional Description

9.1 Scope

Information in this section describes some of the components, functions
and capabilities of the Model 933A.

9.2 Overview

The Arbiter Systems Model 933A Portable Power Sentinel consists of
several blocks. They are: voltage and current inputs, and analog-to-
digital converter; digital signal processor; host processor; display and
keyboard; I/O functions; battery with charger, and power supply; IRIG
(GPS optional) timing synchronization ;. The button features of the
instrument and its measurement functions are described in the sections,
which follow.

Two microprocessors are required to handle the many tasks being per-
formed continuously in such a highly integrated portable instrument.
A Texas Instruments TMS320C33 floating-point DSP unit performs
the digital signal analysis tasks. Instrument I/O functions and inter-
face to the “real world” are handled by an SGS-Thompson ST10F167
16-bit microcontroller. Both of these processors have significant ad-
ditional processing power, which is not used in the initial version of
the 933A. This will allow for the future expansion of features, which is
sure to come, with a minimum amount of upset; indeed, many future
enhancements should be possible with only a firmware upgrade.
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9.3 Clock Synchronization

To provide accurate time synchronization for power measurements, the
933A can use either IRIG-B timing signal from a GPS clock, such as the
Arbiter 1084A/B/C or 1093A/B/C or an optional twelve-channel global
positioning system (GPS) receiver. Proprietary technology developed
by Arbiter Systems and refined in several generations of GPS timing
products also help to achieve accuracy. By comparing the internal 10-
MHz crystal oscillator to the 1 PPS from an IRIG input or the output
of a GPS receiver, the 933A can maintain its frequency at any time
within a few parts in 1010, and time within one microsecond. All of
the internal timing signals are derived from this accurate timebase. If
no external timebase is provided, the 933A keeps time with an internal
Real Time Clock.

9.4 Current Inputs

The current inputs of the 933A are implemented in a removable module.
The standard current module is a three-phase, current input designed
to be accurate to a few ppm over time and temperature (see “Error
Analysis”). This current input section uses a two-stage process, similar
to a two-stage current transformer except that the first stage, with
active feedback is designed to cancel transformer errors and the second
stage provides the current-to-voltage transfer. The current inputs have
an accuracy of a few parts per million.

9.5 Voltage Inputs

The voltage inputs uses low-TC (temperature coefficient) voltage-
divider resistor networks as signal attenuators. Voltage inputs may
be configured as a three-phase, three-element input, with four connec-
tions (A, B, C, and N), or configured as a two-element input, with
independent connections to each element (A+, A-, C+, and C-, for
example).
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9.6 Error Analysis

All identified sources of error in the 933A have been quantified using
worst-case manufacturers’ performance data. These have then been
combined using a root-sum-of-squares (RSS) method to yield a perfor-
mance estimate. Effects due to initial calibration, measurement noise,
temperature, and aging are all included. The reason for using RSS
analysis is beyond the scope of this paper. However, we have found in
our many years’ experience building calibration instruments that this
method yields the most realistic estimate of actual worst-case perfor-
mance, provided that numerous errors contribute significantly to the
overall performance (i.e., no one error dominates), and provided that
worst-case actual data is used for the analysis.

The error analysis, used for the 933A power or energy measurements,
is shown in Table 9.1. Similar analyses have been performed for the
other functions of the instrument, and include most of the same factors
shown here.

Temperature Errors, 0-50◦ C Error, PPM

Current Input, resistor TCR 63

Voltage Input, resistor ratio 50

Voltage Reference (x2) 50

Cal. Source, resistor ratio (x2) 25

Time Stability, 1 year −
Current Input, resistor 25

Voltage Input, resistor ratio < 20

Voltage Reference (x2) 36

Cal. Source, resistor ratio (x2) < 40

Measurement Noise 10

Total RSS Error, Basic 117

Calibration Errors −
Cal. Artifact, Rotek MSB-001A 50

Traceability to National Standards 50

Total Error, RSS 136

Specification (0.05%) 500

Table 9.1: Power/Energy Error Analysis

137



9.7 Signal Sampling

Each of the signals, representing the scaled voltage and current inputs
have their own ADC. Each signal is sampled simultaneously at a rate
of 10,240 samples per second. If connected to an external timing source
(e.g. GPS) it provides the sample clock to the 933A, it is synchronized
to UTC-USNO (GPS), allowing measurements of phase angle across a
power grid to be compared directly.

9.8 Power and Energy

Power and energy are determined by making twenty separate measure-
ments per second of the cross product of voltage and current for each
phase. Each measurement uses 1024 samples (i.e., it takes data from a
100 millisecond window), yielding a 50% overlap.

Apparent power (VA) and reactive power (VAR) are determined from
the results of the voltage and current magnitude measurements (see
next section), using standard identities. The active power measure-
ments and reactive power measurements are then compensated for PT
and CT corrections (see below) using a complex multiplication, and
corrections are performed for transformer iron and copper losses, if
enabled.

At this point, two different things are done with the resulting measure-
ment data. First, a determination is made of the quadrant in which this
data should be registered (Wh delivered or received, VARh delivered
or received.) The results of each measurement cycle (20/sec) are then
added to the proper set of registers. These registers are stored period-
ically, and accumulation restarted from zero. The user may configure
the unit for different intervals to register energy.

The second thing that is done with the data is to determine the actual
power level. This number will be displayed on the front panel (as watts
or VARs), and it will be returned via the serial interface if a simple
request for “power” is made. This result is calculated by averaging
the 20 power measurements made during each second. Therefore, the
update rate for this quantity is once per second. This data is not
registered separately depending on the quadrant, as the energy data
is; therefore, it is theoretically possible, if the direction of power flow
changes periodically, that the sum of measurements reported over the
serial interface may gradually depart from the registered energy data.
This is due to the loss of information in the averaging process; the
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registered data are the most accurate. The averaged data are provided
primarily as a convenience or for system control purposes; it is not
intended for billing purposes.

9.9 Voltage and Current

Voltage and current are measured in a similar fashion to power, using
overlapping 1024-point measurements. In this case, however, the cross
product is replaced with the square of the voltage or current samples.
The square root of the resulting sum is proportional to the rms voltage
or current value during the measurement interval. This value is cor-
rected for the CT and/or PT correction factors before further use. The
933A uses the resulting data to correct the energy measurements, as
described above. It also provides data to the host system by averaging
it over one-second intervals.

9.10 CT and PT Compensation

To correct for the inaccuracies of the CT’s and PT’s used in the meter-
ing setup, CT and PT compensation may be enabled. Since the system
voltage is relatively constant, the PT compensation factor is a single,
complex (i.e., magnitude and phase, or real and imaginary) correction
factor.

CT compensation is more complicated than PT compensation. Due to
the fact that magnetizing currents in CT’s are not exactly proportional
to the load current, a matrix is used. This allows the entry of several
different compensation factors measured at different current levels. The
933A interpolates between the numbers in this table (also complex) to
determine the correction factor to be used.

Correction for energy is performed using the (complex) product of the
PT and CT factors. Correction for voltage or current is performed
using the magnitude of the appropriate factor. Correction for phase
angle is made using the phase of the appropriate component, i.e. the
arctangent of the complex value. The actual calculation performed may
be different than this description, due to computational considerations
(a complex multiplication is far faster than a trigonometric operation
such as an arctangent, for example); however, the end result will be as
described.
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9.11 Transformer Compensation

There are two different types of transformer compensation. They are
used to correct for the losses in a transformer when primary-side meter-
ing is used to meter the energy delivered to a customer at the secondary
of the transformer.

Copper compensation is used to correct for the I2R losses in the trans-
former windings due primarily to their (nonzero) resistance. As you
would expect, this effect is primarily active (resistive), although there
may be minor reactive effects, and it is proportional to the current
squared. This factor allows the user to correct for these losses. It is
a complex factor, providing both watts and VARs correction, and is
proportional to current squared; i.e. so many watts and VARs are to
be subtracted from the registered amounts per ampere squared of load
current.

Iron losses (also called core losses) are due to magnetizing currents (the
small amount of current required to generate the flux in the core, which
is unrelated to the load current) and eddy current losses in the core
material. These are approximately proportional to the square (watts)
or 4th power (VARs) of the voltage, and the compensation is performed
using the same basic method as described above for copper loss.

9.12 DC Offsets

DC offsets may be present in the signals applied to the input of the
933A, although this is unusual. More commonly, small dc errors in the
measurement circuit result in nonzero average of the samples.

This potential source of error must be corrected to obtain maximum
accuracy, since the 933A makes wideband measurements of power, volt-
age, and current. Components at any frequency within the measure-
ment bandwidth, including dc, will affect the measurement. Therefore,
part of the measurement process is to average the (windowed) data,
measuring the dc component. The effects of dc offsets are then sub-
tracted from the results.
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9.13 Phase and Frequency

As a part of its measurement process, the 933A performs a fast Fourier
transform (FFT) of the windowed voltage and current samples. In
accordance with IEC 61000-4-7, this process is performed twenty times
per second, using overlapping 1024-sample Hanning window data. This
yields new FFT results twenty times per second for each voltage and
current input, for a total of 120 FFT’s per second. Phase angle may
be determined from the relationship between the real and imaginary
component of the fundamental-frequency bin of the FFT. (Since the
window is 100 ms wide, each bin is 10 Hz apart; therefore, this is bin 5
for 50 Hz and bin 6 for 60 Hz.)

So long as there is significant measured energy in the bin, frequency
offsets do not affect the measured phase angle. This is true as long
as the signal being measured is the main source of energy in the bin;
i.e. there is minimal leakage from adjacent bins, and minimal noise.
Provided that the frequency is anywhere near nominal (within 10 Hz
or so), the phase measurement is perfectly usable.

The phase measurements may be compared to determine phase angle
between voltages and currents or between any two voltages or currents.
Because the sampling process may be synchronized via IRIG (GPS) to
UTC, absolute phase angle measurements may be made and compared
between two units located at some distance from one another.

Frequency is measured by taking the difference in phase angle between
subsequent measurements, based on the identity f = dφ/dt. Frequency
is averaged over one second prior to being displayed or made available
for output.

The 933A is the first product to make absolute (i.e. relative to UTC
time) phase-angle measurements available in an economical unit which
will be widely applied. Measurements of phase angle have been avail-
able before, but most products have not offered accurate time synchro-
nization, and therefore most users are not experienced with the concept
of absolute phase. All phase angles in the 933A are reported as absolute
phase angles, relative to UTC (USNO) top-of-second. A phase angle
of zero degrees is defined as corresponding to the positive maximum
of a cosine wave being coincident with 1PPS-UTC(USNO). Relative
phase angles, for example between phases, or between a voltage and a
current, may be calculated by subtraction. Relative phases of harmon-
ics may also be found by subtraction; however, the harmonic number
prior to subtraction must multiply the fundamental, absolute phase.
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This is because the subtraction is actually one of time; the purpose
being to ’realign’ the reference point to correspond to zero degrees on
the fundamental. The phase angle corresponding to this time shift is
proportional to the frequency.

9.14 Harmonics

Harmonics are measured using overlapping Hanning window FFT’s of
1024 samples and 100 ms window length. Based on the instantaneous
frequency, the location of the bins containing significant energy for each
harmonic are determined. This is a total of three bins, one approxi-
mately centered on the harmonic and those two adjacent to it. Then,
the energy in those three bins is totaled, resulting in the energy for
that harmonic. This can then easily be expressed as a percentage of
the rms signal level, or in whatever form is required. While there is
a closed-form correction, which can be employed to find the harmonic
magnitude in the presence of frequency errors, this approximation was
chosen because it is much faster and gives adequate performance.

There is an error in this approximation, due to the fact that there will
be a small amount of energy leakage into nearby bins, which will not be
included in the three measured bins. This is generally of little conse-
quence when the frequency is close to being accurate (which is most of
the time), since the amount of energy outside of the three bins summed
is so low. Finally, with the Hanning window, there is no signal at all
outside of these three bins if the frequency is exact. In the real world,
however, the frequency will be off somewhat, and it is reasonable to ask
how large the error can be. For small frequency errors, say 0.01 Hz,
the 50th harmonic will be 0.5 Hz from the center of the nominal bin.
This results in an error of about 0.005%, which is insignificant. The
worst-case error will occur when a harmonic is very nearly centered be-
tween two bins. In this case, the algorithm described above will ’miss’
a bin containing a signal with amplitude of about 17% of the actual
harmonic amplitude. The energy contained in this bin is then (0.17)2 or
about 2.9% of the total energy, resulting in a measured energy 0.971x
what it should be. The measured harmonic amplitude will then be
(0.971)0.5 or about -1.5% in error. This is well within the specification
limits (5%) of IEC 61000-4-7. This worst-case error would occur for the
50th harmonic with a fundamental frequency error of 0.1 Hz. At lower
harmonics, the frequency error must be progressively greater; for ex-
ample, to result in a -1.5% error in measuring the 9th harmonic would
require a fundamental frequency offset of 0.556 Hz. The phase angle of
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the harmonics is determined by taking the arctangent of the real and
imaginary components of the bin closest to each harmonic. This in-
formation cannot be used, however, in the averaging process described
in IEC 61000-4-7, because this specification requires the rms average
of a series of measurements. This, by definition, requires magnitude
data only. Therefore, there are two different harmonic tables available
from the unit. The averaged harmonic data, in accordance with IEC
61000-4-7, is provided in a 300-element array (6 channels x 50 harmon-
ics), averaged over the interval specified by the user (typically 10 or
15 minutes). The harmonic magnitude and phase data are provided
in a 600-element array, once per second. The harmonic magnitude is
the rms value over the preceding second, and the phase angle is the
‘instantaneous,’ absolute (based on a 100 ms window centered at top
of second) phase angle, as described in the preceding paragraph.

9.15 Flicker

Flicker is measured in accordance with IEC 61000-4-15, the successor
standard to IEC 868. Unlike the other measurements described above,
flicker measurement is a continuous process. This process is performed
using a sample rate of 640 samples per second (sps). Anti-alias (dec-
imation) filtering is performed on the 10240 sps data stream, and the
resulting samples are further processed following the block diagram
suggested in IEC 61000-4-15. The resulting measurements of flicker
perceptibility are classified using a 256-level logarithmic classifier at
the full 640 sps rate. Pst is then determined every ten minutes (or as
specified), as described by the standards.

Although no standards currently require it, the 933A also measures
flicker on the current inputs. This information can be useful in deter-
mining whether a customer’s load is causing flicker on the power sys-
tem, or whether the customer is being subjected to flicker from other
sources. It is unrealistic to penalize a utility for ‘poor power quality’
at a customer’s load when the cause of the problem is the load itself.

9.16 Interruptions

Interruptions are monitored on the voltage inputs by comparing
the 20/second voltage measurements with a user-supplied threshold.
Events are triggered when the voltage dips below the preset threshold.
These can cause the logging of pre- and postfault data, contact closure,
or any of the other actions described under “Event Logging.”
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9.17 Voltage Fluctuations

Voltage fluctuations are monitored by classifying the 20/second voltage
data, per phase, with a 256-step linear classifier covering a range of 20%
of nominal voltage. These data are then summarized as a cumulative
probability table over a specified interval − typically 15 minutes. In
addition, the minimum, maximum, mean and standard deviation are
calculated. The data may be recorded in flash memory either contin-
uously or on demand. Voltage fluctuations corresponding to system
stability events may also be monitored and a trigger generated using
Schulz-Laios filtering of the voltages.

9.18 System Time Deviation

System time deviation, which is the accumulated error of a clock using
the system frequency as its reference, compared to an absolute reference
such as UTC, is determined from the 20/second phase data described
earlier. System time deviation is accumulated as integer cycles of er-
ror plus fractional phase, and is converted to seconds as needed. The
positive-sequence voltage phase angle is used for this measurement.
Since this is an integrated value, the constant of integration (initial
time offset value) must be specified by the user.

9.19 Phasor Measurements

Phasor data are formatted and output in accordance with IEEE Stan-
dard 1344-1995. Phasors consist of the real and imaginary component
of magnitude for the voltages and currents at a particular point in a
power distribution system, along with suitable time synchronization
fields and other information. This information is available in real time,
and is based on the measured fundamental voltage, current, and phase
angle described above, at a rate of 20 records per second. There is a
measurement delay due to the data acquisition delay of 50 ms, signal
processing time of approximately 15 ms, and data transfer time which
depends on the data rate.

9.20 Phase Balance

The 933A measures phase balance by calculating the symmetrical se-
quence components (positive, negative, and zero sequence) for the
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three-phase voltage input. Normally, if the unit is connected prop-
erly, the positive-sequence voltage will be equal to the line voltage and
the negative- and zero-sequence voltages will be approximately zero.
In the event that a user-specified limit on the imbalance (See “Trigger-
ing,” later in this section) is exceeded, an event will be recognized. In
addition, the sequence components are averaged over a user-specified
interval (typically 10 or 15 minutes) and may be logged if desired. These
calculations are performed using the voltage magnitude and phase in-
formation, 20/second.

9.21 Load Balance

Load balance is calculated in much the same way as phase balance,
except on the customer’s load current. The 933A uses both of these
measurements to identify serious power system problems, such as a
dropped phase, which could cause serious damage to the utility’s and
the customer’s equipment.

9.22 Flash Memory and Event Logging

The 933A has two separate 128 megabyte flash memories for data and
event logging. One memory is used exclusively for storing waveform
data. The waveform data is stored for all input channels at the full data
rate with 16 bit resolution. 0.5 seconds of waveform data is continuously
stored in RAM. Once an event designated to record waveform data
occurs, this data is transferred to Flash and waveform data continues
to be stored according to user defined times and conditions. About 10
minutes of waveform data may be stored.

The other Flash memory may be used to record three basic types of
information: (1) registered quantities, (2) event data, and (3) system
status events. Registered quantities are recorded on a fixed schedule
and may include many more items than a typical energy meter, includ-
ing just about any function the instrument can measure. The event
data are logged on the occurrence of an event designated to initiate
logging. System status is used for advanced monitoring and control of
the operation of the 933A and the system node to which it is connected.

Events are defined as any measured quantity exceeding a user-specified
threshold, an external trigger, or an internal state of the 933A (low
flash memory, for example).
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There is a great deal of flexibility as to what may be recorded in flash
memory at the time an event is recognized. Recorded information may
any of the following:

� Time of event
� Type of event
� State of measured quantities
� Pre and post-event data
� Any of the measured quantities - e.g. voltage, power, waveform,

etc.

The 933A must be configured in advance to specify the events being
recognized and actions to be taken.

To maximize usage of flash memory, it is important to distinguish reg-
istered quantities from event log data. The amount of memory needed
to record a certain number of registered items for a certain period can
be determined exactly, whereas the amount of memory required to log
events depends on the number and type of events, and the number of
items to be recorded for each type. Since the number and type of events
cannot be known a priori, the amount of memory required also cannot
be stated with certainty. The 933A handles this by allocating sufficient
memory as required for the registered quantities over the specified pe-
riod of time, and then making whatever memory is left available for
event logging. To deal with low register or event memory conditions,
the 933A can be configured to initiate an auto-dial call or contact clo-
sure when the condition is met. Memory is allocated in 64-kbyte blocks,
which is the block size of the flash memory.

Flash memory must be erased in blocks, and data cannot be overwritten
until its block is completely erased. Therefore, the normal process will
be to first read out the desired data, and then erase the blocks, making
them available for reuse. All blocks of data are password-protected,
having two levels of security from separate permissions: one to access
the data, and a second to clear it from memory. This means that
registered data and event data each have their own sets of permissions.
This would normally be used to separate billing data from operational
data.

9.23 Optional Contact Outputs

indexcontacts, optional output Four contact outputs may be used to re-
port events recognized by the 933A, or they may be controlled remotely,
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by command. They may also be operated on a schedule, which may
be downloaded for up to 30 days in advance. In addition to reporting
events, these contacts may be used to synchronize external equipment
or to operate load-control switch gear.

9.24 Optional Event Inputs

Four external event inputs are also provided. These are optically iso-
lated and accept dc signals at levels from 24 to 240 volts (an internal
modification will allow 5 volt logic-level inputs). Application of a signal
to one of these inputs will be time-tagged to one microsecond resolu-
tion. Resultant actions from an event input are described above under
triggers, Sections 3, 5 and 7.

9.25 Serial Channels

The two standard serial channels are RS-232 and USB. Each chan-
nel can have access to all functions of the 933A. Alternatively, certain
functions (such as the ability to clear the revenue registers) may be
enabled or disabled independently. The RS-232 channel has a RJ-11
(6-position) modular connector useful for connecting with a standard
phone cable. Use a RJ-11 to DB-9F adapter at the end of the phone ca-
ble to connect the 933A to a computer. These adapters may be rewired
in the field to match interface requirements. Both serial channels may
be operated simultaneously, each serving different hosts with separate
access authorization and information channels.

9.26 Triggering in the Model 933A

The digital signal processor (DSP) in the 933A Power Sentinel mea-
sures dozens of different parameters of the applied input signals, in
many cases at a rate of 20 measurements per second. Most of these
parameters may be used to trigger an alarm condition, based on preset
thresholds and conditions.

Triggering in the DSP works as follows. First, there are 31 different
measurement types that may be selected for processing by the trig-
ger algorithm (Table 2). For each of these, there are (typically) four
different measurement channels, A, C, B and either average, total, or
maximum (of A, C, and B). Thus, there are a total of 124 different
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signals (corresponding to individual measurement results) which can
be selected. Not all of these are defined at this time, however.

Second, there are 32 trigger channels, which may be configured for use
concurrently (Table 3). Each of these may be set to use any of the 124
signals as their input. For each channel, there is a limit, which may be
set by the user, as well as a reference value, which may be used by the
trigger logic. The limit function logic may be set to any of four modes:
x > limit;x < limit, |x| > limit; or|x − ref | > limit. In addition,
each trigger channel may be made dependent on the results of another
channel. It may be set so that the channel requires the other trigger to
be either active or inactive before proceeding with its own comparison.
Comparisons are made at the 20 per second rate for all channels, even
for input signals, which change more slowly.

Each channel also has a dwell time, or delay time, register. Before it will
generate a trigger, the specified signal must exceed its limit condition
for a number of comparisons equal to this register (plus one). The
register is a 16-bit unsigned integer, having a range of 0 to 65535 cycles.
Since comparisons are performed 20 times per second, this corresponds
to a range of dwell time of 0 to 3276.75 seconds. A value of 0 allows
the trigger to be recognized at any time the corresponding condition is
true; a value of 1 (0.05 seconds) requires the trigger condition to persist
for two consecutive comparisons, and so on.

Considering all of the different input signal possibilities, along with
the different limit modes and inter-channel dependencies, there are an
almost limitless number of possible combinations of settings for each
trigger channel.

9.27 Detecting Oscillatory Transients and
Other Anomalies

Special logic is included in the 933A to implement the algorithms de-
scribed by Schulz and Laios [1], which are designed to detect power
system anomalies such as oscillatory transients. There are six chan-
nels dedicated to performing this function in the 933A (Table 4). Each
of these may have any of the 124 signals described above as its in-
put. Each channel has three outputs: a low-pass-filtered (‘bound’)
output, a rate-of-change output, and an oscillation-detector output.
Each channel also has three control parameters (in addition to the in-
put signal selection): the rate-of-change filter time constant (T1 in [1]);
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the oscillation-detector time constant (T2 in [1]); and the oscillation-
detector reset threshold, also described in [1]. These parameters con-
trol only the operation of these signal-processing blocks, and do not in
themselves generate any triggers. To generate triggers, select one of
the three outputs of one of the channels in this block. This serves as
an input to one of the 32 trigger channels. As recommended by Schulz
and Laios, the input filtering for this block is the BPA #1 low-pass,
described in [2], which is a 12-point Hanning-weighted FIR low-pass
filter having a group delay of 0.3 seconds at a 20/second sampling rate.
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Table 9.2: Signal Functions Available for Triggering

ID# Function Rate Channels
Available

0 Off 20/sec N/A

1 Voltage 20/sec A,B,C, Ave.1

2 Current 20/sec A,B,C, Ave.2

3 Active Power (Watts) 20/sec A,B,C, Total3

4 Relative Power (VARs) 20/sec A,B,C, Total3

5 Apparent Power 20/sec A,B,C, Total3

6 Power Factor (PF) 20/sec A,B,C, Total3

7 Sequence Voltage
Components

20/sec Zero, Pos., Neg.

8 Sequence Current
Components

20/sec Zero, Pos., Neg.

9 Phase Bal. Ratio, Derived
from sequence components

20/sec Zero, Pos., Neg.

10 Frequency and Time 20/sec Freq., DF, df/dt, DT

11 THD Voltage 1/sec A,C,B, max (A,C,B)1

12 THD Current 1/sec A,C,B, max (A,C,B)2

13 Harmonic VRMS 1/sec A,C,B, max (A,C,B)1

14 Harmonic IRMS 1/sec A,C,B, max (A,C,B)2

15 K-Factor, voltage 1/sec A,C,B, max (A,C,B)1

16 K-Factor, current 1/sec A,C,B, max (A,C,B)2

17 Flicker, instantaneous,
voltage

1/sec A,C,B, max (A,C,B)1

18 Flicker, PST, voltage 1/sec A,C,B, max (A,C,B)1

19 Flicker, instantaneous
current

1/sec A,C,B, max (A,C,B)2

20 Flicker, PST, current 1/sec A,C,B, max (A,C,B)2

21-25 Reserved TBD TBD
26-31 Transient Detector,

channel 0-5
20/sec Bound, rate/ch., osc.

1. Average or maximum of 3 voltage channels in 3P4W3E and 3P3W2E input
mode, 1 channel in 1P2W1E mode, and 2 channels in other modes. In 3P3W2E
mode, the voltage VAC is derived internally by point-by-point calculation after
A/D conversion. The voltage VB, synthesized internally in 3P4W21/2E mode, does
not correspond to an actual physical quantity and is not included in the analysis,
although measurements can be made on the synthesized signal.

2. Average or maximum of 3 current channels in 3-phase modes, 1 channel in
1P2W3E mode, and 2 channels in other modes. In 3P3W2E mode, the current Ib
is derived internally by point-by-point calculation after A/D conversion.

3. Total of 3 elements in 3P4W3E and 3P4W21/2E modes, 1 element in 1P2W1E
mode, and 2 elements in other modes.
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Table 9.3: Trigger Channel Parameter Summary (32 Channel)

Function Range or Options

Input Signal 1-31, per Table A.2 above (set to 0 if not
used)

Channel 0-3, per right column in table above

Trigger Dependency 0-2, Off, Active, Inactive

Master Channel 0-31, any other trigger channel

Limit Type 0-3; x > limit, x < limit, |x| > limit, |x −
ref | < limit

Dwell (delay) time 0-65535, 50 ms/count; 0 to 3276.5 seconds

Limit Value Floating Pt, in measurement units (volts,
watts, . . . )

Reference Value Floating Pt, in measurement units (volts,
watts, . . . )

Table 9.4: Schulz-Laios Transient Detector Algorithm Control (6 Chan-
nel)[1]

Function Range or Options

T1 High-pass (rate detector) time constant, sec-
onds Minimum 0.05 seconds, typical 0.5 sec-
onds

T2 Oscillatory detector low-pass time constant,
seconds Minimum 0.05 seconds, typical 5.0
seconds

Oscillatory detector
Reset threshold

Threshold in measurement units. Set to any
negative number to disable reset

Input Signal 0-31, per Table A.2

Channel 0-3, per right column in Table A.2

[1] Schulz, Richard P. and Beverly B. Laios, Triggering Trade offs for Recording
Dynamics, IEEE Computer Applications in Power ; April 1997, pp. 44ff

[2] Hauer, John F., and Fazlollah Vakili, An Oscillation Detector Used in
the BPA Power System Disturbance Monitor, IEEE Transactions on Power
Systems, Vol. 5 No. 1, Feb. 1990, pp. 74ff
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Chapter 10

Connection Diagrams
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Figure 10.1: 1–Phase, 2–Wire, 1–Element − Direct Connection
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Figure 10.2: 1–Phase, 2–Wire, 1–1/2-Element − Direct Connection
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Figure 10.3: 1–Phase, 3–Wire, 2–Element Direct Connection
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Figure 10.4: 3–Phase, 3–Wire, 2–Element, Delta − Direct Connection
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Figure 10.5: 3–Phase, 4–Wire, 2.5-Element Direct Connection
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Figure 10.6: 3–Phase, 4–Wire, 3–Element Connection
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Figure 10.7: 1–Phase, 2–Wire, 1–Element, Using CT/PT Connection
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Figure 10.8: 1–Phase, 2–Wire, 1 1/2–Element, Using CT/PT Connec-
tion
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Figure 10.9: 1–Phase, 3–Wire, 2–Element, Using CT/PT Connection
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Figure 10.10: 3–Phase, 3–Wire, 2–Element Delta, Using
CT/PT Connection
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Figure 10.11: 3–Phase, 4–Wire, 2 1/2–Element, Using CT/PT Con-
nection
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Figure 10.12: 3–Phase, 4–Wire, 3–Element, Using CT/PT Connection
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Appendix A

Glossary

A.1 DHCP

Dynamic Host Configuration Protocol (DHCP) is a communications
protocol that lets network administrators manage centrally and auto-
mate the assignment of Internet Protocol (IP) addresses in an organi-
zation’s network. Using the Internet Protocol, each machine that can
connect to the Internet needs a unique IP address. When an organiza-
tion sets up its computer users with a connection to the Internet, an
IP address must be assigned to each machine. Without DHCP, the IP
address must be entered manually at each computer and, if computers
move to another location in another part of the network, a new IP ad-
dress must be entered. DHCP lets a network administrator supervise
and distribute IP addresses from a central point and automatically
sends a new IP address when a computer is plugged into a different
place in the network.

A.2 DNS

A Domain Name Server (DNS) is used to map names to IP addresses
and vice versa. Domain Name Servers maintain central lists of domain
name/IP addresses and map the domain names in your Internet re-
quests to other servers on the Internet until the specified web site is
found.
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A.3 DSP

Digital Signal Processing: DSP refers the hardware (DSP microcon-
troller and associated components) and firmware (the programming
code running the microcontroller) that process the input signals and
calculate the required output data.

A.4 Ethernet

Ethernet is the most widely-installed local area network (LAN) tech-
nology. Specified in a standard, IEEE 802.3, Ethernet was originally
developed by Xerox and then developed further by Xerox, DEC, and
Intel. An Ethernet LAN typically uses coaxial cable or special grades
of twisted pair wires. Ethernet is also used in wireless LAN’s. The
most commonly installed Ethernet systems are called 10BASE-T and
provide transmission speeds up to 10 Mbps. Connected devices com-
pete for access using a Carrier Sense Multiple Access with Collision
Detection (CSMA/CD) protocol.

A.5 Fast Ethernet

Fast Ethernet or 100BASE-T provides transmission speeds up to 100
megabits per second and is typically used for LAN backbone systems,
supporting workstations with 10BASE-T cards. Gigabit Ethernet pro-
vides an even higher level of backbone support at 1000 megabits per
second (1 gigabit or 1 billion bits per second). 10-GB Ethernet provides
up to 10 billion bits per second.

A.6 Flash

Nonvolatile memory used for storing programs and data. In the Model
933A, this term primarily refers to a 128 MB memory device used for
data storage.
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A.7 K Factor

K–Factor is a weighting of the harmonic load currents according to their
effects on transformer heating, as derived from ANSI/IEEE C57.110.
A K–Factor of 1.0 indicates a linear load (no harmonics). The higher
the K–Factor, the greater the harmonic heating effects. It is calculated
based on the following equation:

(A.1) KFactor =
(V1 × 1)2 + · · ·+ (V50 × 50)2

V 2
1 + · · ·+ V 2

50

where each component is multiplied by the harmonic number
(e.g.1, 2, · · · , 50), called a weighting factor.

Harmonic load currents significantly affect power distribution system
design. Harmonics create additional losses through the skin effect at
high frequencies and through higher RMS load currents. By specifying
K-Rated transformers and using other techniques, power distribution
systems and customer equipment should have lower failure rate.

Harmonic Summary data returned from the 933A can be a strong indi-
cator of what harmonics are being returned to the distribution system
location by users with nonlinear loads. Harmonic content is potentially
damaging both to the power company and the user. If adequate pro-
tection is not taken, equipment will experience early failure and also
lower overall efficiency.

A.8 KYZ (Pulse Metering)

KYZ Pulse Metering is a method of measuring energy usage by me-
chanical contact closures and openings at the meter. Each opening
and each closure are separately counted as one energy unit, which unit
is normally assigned by the utility provider. KYZ pulse metering is
normally counted at the end of a line connected to the meter.

A.9 Kp Register Scale Factors

A.10 Linking

Establishing communications between the Model 933A and a computer
device. Normally, this is done using PSCSV software.
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A.11 RMS K

RMS K is the rms sum of all of the harmonic energy, including the
fundamental (i.e. 1 − 50), with each harmonic multiplied by the square
of the harmonic number. It has the same units as the signal, i.e. volts
or amps. For a clean signal, it will be almost exactly equal to the
fundamental value. RMS K is calculated from the following equation.

(A.2) RMS(K) =
√

(V1 × 1)2 + · · ·+ (V50 × 50)2

where V1 is the fundamental voltage and includes all the harmonics up
to the 50th.

A.12 RMS THD

The RMS Total Harmonic Distortion, or THD, is the rms value of all
of the harmonics 2 - 50 and has the same units, volts or amps. RMS
THD is calculated from the following equation:

(A.3) RMS THD =
√

V 2
2 + · · ·+ V 2

50

where Vn is the harmonic rms voltage, and n equals harmonic number.

A.13 TFTP

Trivial File Transfer Protocol (TFTP) is an Internet software utility
for transferring files that is simpler to use than the File Transfer Pro-
tocol (FTP) but less capable. It is used where user authentication
and directory visibility are not required. TFTP uses the User Data-
gram Protocol (UDP) rather than the Transmission Control Protocol
(TCP). TFTP is described formally in RFC (Request for Comments)
1350.
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A.14 THD F

THD F is the Total Harmonic Distortion compared to the fundamental
and expressed as a percentage. THD F is calculated from thee following
equation.

(A.4) THD(F ) =

√
V 2

2 + · · ·+ V 2
50

V1
100%

where V1 is fundamental voltage, and V50 is the highest measured har-
monic.

A.15 THD T

THD T is the Total Harmonic Distortion voltage compared to the total
voltage (fundamental plus harmonics) and expressed as a percent. THD
T is calculated from the following equation.

(A.5) THD(T ) =

√
V 2

2 + · · ·+ V 2
50√

V 2
1 + · · ·+ V 2

50

100%

where the denominator now includes the sum of rms harmonic voltages
plus the fundamental.
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Appendix B

Uploading New
Firmware

The Model 933A Portable Power Sentinel allows you to upload new
firmware via the RS-232 port from a connected computer with a serial
port. If your computer does not have a serial port, then you can use a
USB-to-Serial adapter to connect between the cable/adapter assembly
that comes with the 933A and the computer.

B.1 Obtaining the Latest Firmware

Download the latest firmware version and 933Uploader.exe program
from the Arbiter Systems web site. The web address is listed below.

http://www.arbiter.com/pscsv/933index.php

The firmware will be in zipped format and does not need to be un-
zipped. The uploader program automatically unzips the file when load-
ing it.
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B.2 Uploading Procedure

1. Connect the cable(s) and adapters between the computer and the
933A RS-232 port.

2. Start the uploader software, 933Uploader.exe. It should appear
as shown in Figure B.1.

3. Check the settings under “Serial Setup” on the Model 933A. Press
the SETUP key, then 2-Serial Setup. Make sure you know the
baud rate.

4. On the 933A Flash Update Application, select Settings > Serial
Port and select the correct port.

5. Select Settings > Upload Mode > RS-232 Serial Port.

6. Select Settings > Baud Rate > (select the same baud rate as the
933A).

Figure B.1: Starting the 933A Uploader
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7. Click the Open button or select File > Open, browse to locate
the zipped firmware that you downloaded, select the file and click
Open. The file should be automatically unzipped and ready to
upload to the 933A. The uploader window should appear as in
Figure B.2 and provide the firmware information.

Figure B.2: Uploaded File Information

8. Click the Upload button (blue with an UP arrow) and the file
will transfer to the 933A. The uploader will start by erasing flash
in the 933A, and indicated by the progress screen. After flash
has been erased, the program should indicate the progress of the
upload with a progress bar as seen in Figure B.3.

Figure B.3: Uploader Progress Window
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At the completion of a successful upload, the uploader application
will indicate the time that the firmware Update was completed
and that it was successful as indicated in Figure B.4.

Figure B.4: Successful Uploaded File Information

9. You can close the uploader program.

10. The 933A should be ready to use, and not need to have power
cycled.

If you should have any questions about uploading new firmware to
the Model 933A, contact the Arbiter Systems technical support at the
information listed inside the front cover of this manual.
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Appendix C

CE Mark Certification

C.1 Introduction

On the following pages contain the individual CE Mark Certifications
for models covered in this manual. This includes Model 933A.
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Declaration of Conformity with European
Union Directives

Date of Issue: March 27, 2008

Directives: 89/336/EEC Electromagnetic Compatibility

73/23/ EEC Low Voltage Safety

Model Number(s): 933A Portable Power Sentinel

Manufacturer: Arbiter Systems, Inc.

1324 Vendels Circle, Suite 121

Paso Robles, CA 93446 − USA

Harmonized EN55011 Class A, Radiated and Conducted
Emissions

Standard EN50082-1 Generic Immunity, Part 1

Referenced: Residential, Commercial and Light Industrial

environments

EN61010-1 Safety requirements of Electrical

Equipment for Measurement, Control

and Laboratory Use.

Signed:

Signatory: Bruce H. Roeder

This certificate declares that the described equipment conforms to
the applicable requirements of the directives on Electromagnetic
Compatibility 89/339/EEC, Safety 73/23/EEC, and amendments by
93/68/EEC adopted by the European Union.
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Index

933A Accessories
100 Amp clamp-on CT, 9
400 Amp direct CT, 9
811AT current lead set, 7
813AT voltage lead set, 5
813BT voltage lead set, 5
816AT current lead set, 6
933A-02, 933A-03

low current modules, 9
adjustable bail, 8
auxiliary I/O module, 11
gps antenna module, 10
included, 2

933A Theory, see Functional Description

anticreep, 94
Appendix

A, 167
B, 173
C, 177

application software
PSCSV�, 30

Aux I/O port, 23

Battery
specifications, 133

battery
charging, 16
status screen, 17
symbol, 16
type, 1

Broadcast values
basic data, 96
energy data, 97
harmonic summary data, 99
harmonic values, 98
list, 102
phasor data, 101
waveform data, 100

button (PSCSV) definitions, 83

CE mark, 177

CE mark certifications, 177
clock

free running, 30, 38, 39
sync with gps, 38
sync with IRIG-B, 38
synchronized mode, 40
UTC or Local, 40

clock (RTC), 30
clock accuracy

free running, 30
synchronized, 30

clock synchronization, description, 136
communication

Ethernet, 90
ports, 22
RS-232, 23
USB, 22

configuration, instrument, 62
configure measurement

parameters
from PSCSV, 93

connection
electrical system, see Setup Menus,

Input
electrical system

diagrams, 153
with pc, see linking

connection diagram
3P4W3E using CT/PT, 166

connection diagrams
1P2W15E direct, 166
1P2W15E using CT/PT, 166
1P2W1E direct, 166
1P2W1E using CT/PT, 166
1P3W2E direct, 166
1P3W2E using CT/PT, 166
3P3W2E delta direct, 166
3P3W2E delta using CT/PT, 166
3P4W25E direct, 166
3P4W25E using CT/PT, 166
3P4W3E direct, 166
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connectors
Aux I/O, 23
communication, 22
current, 20
gps, 21
ground, 19
IEC-320, 23
IRIG-B, 22
list, 19
RS=232C, 23
time sync, 21
USB, 22
voltage, 20

contact outputs, optional, 11, 23
copyright, v
CT compensation,

description, 139
CT/PT compensation, 44
current

measurement, 139
current inputs, 20
current inputs, description, 136
Current Lead Sets, 6
current module

1 Amp, 9
20 Amp, 20

data types
using PSCSV software, 96

DC offsets, description, 140
detecting oscillatory

transients, 148
DHCP, 167
display key, 24
display lighting, 26
Display Menus

Basic Data List, 61
Config & Status, 62

with GPS sync, 63
Energy Tabulation, 59
Harmonic Results, 52
min–max setup, 50
Phasor Display, 60
Power Quality, 57

Flicker information, 58
Power Tabulation, 56
Tabular Results, 51
V & I Tabulation, 54

Impedance, 55
Ratio, 55
Sequence, 55

Waveform Display, 53
DNS, 167

downloading data
broadcast data types, 96

Basic Data, 96
Energy Data, 97
Harmonic Data, 98
Harmonic Summary, 99
Phasor Data, 101
Waveform, 100

using Hyperterminal, 33
using Tera Term Pro, 32

DSP, 168

energy calculation,
description, 138

error analysis, description, 137
Ethernet, 168
Ethernet, Fast, 168
event inputs (optional), 147
event logging, 145

Fast Ethernet, 168
file transfer

bitmapped, 32
HyperTerminal, 33
Tera Term Pro, 32

flash, 168
flash memory, 145

download events, 85
erase, 85
specifications, 129
status, 85

flash memory, description, 145
flicker measurement,

description, 143
frequency measurement,

description, 141
front panel description, 18
function keys, see keys, function
Functional Description

clock synchronization, 136
current inputs, 136
DC offsets, 140
detecting oscillatory

transients, 148
error analysis, 137
flash memory, 145
flicker, 143
harmonics, 142
interruptions, 143
load balance, 145
optional contact outputs, 146
optional event inputs, 147
phase and frequency, 141
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phase balance, 144
phasor measurements, 144
power and energy, 138
PT and CT

compensation, 139
serial channels, 147
signal sampling, 138
system time deviation, 144
transformer

compensation, 140
triggering, 147
voltage and current, 139
voltage fluctuations, 144
voltage inputs, 136

fuse
replacing, 23
type, 23

ground
chassis, 19

harmonics
broadcasting, 98
capability, 3
graphical, 52
measurement, 142
summary

toolbar, 84
summary data, 99
tabular, 52
toolbar, 84
unwanted, 46

high-speed data capture, 117
HyperTerminal, see file transfer

IEC-320 power inlet, 1, 23
installing

low-current modules, 47
interruption measurement,

description, 143
IRIG-B timing, 30
issuance, ii

K Factor, 99, 111, 150, 169
keys, function

cursor & enter, 26
display, 24
display lighting, 26
hold, 28
log, 27
numeric keypad, 27
on/off, 24
print, 28

review, 27
setup, 25
soft, 25

Kp register scale factor, 123, 169
KYZ

Aux I/O Module, 120
contacts, 122
pulse metering, 169

linking, 169
933A and PC, 81

load balance, description, 145
loss compensation (xfmr), 94

measurement
basic data, 61
energy, 59
flicker, 58
harmonic, 52
min–max, 50
phasor, 60
power, 56
power quality, 57
sequence voltages

and currents, 55
show impedance, 55
tabular results, 51
V I tabulation, 54
waveform, 53

Menus
edit, 87
view, 86

menus
display

seeDisplay Menus, 49
setup

seeSetup Menus, 35

neutral
synthesized, 20

numeric keypad, 27

operation
ac power, 15
aux I/O signals, 23
basic, 15
battery, 16
battery charging, 16
battery indicator, 28
chassis ground, 19
communication signals, 22
connecting current signals, 20
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connecting synchronizing signals,
21

connecting voltage signals, 20
data modes, 29
date and time, 30
display

basic, 61
config and status, 62
energy, 59
harmonics, 52
min–max readings, 50
phasors, 60
power, 56
power quality, 57
voltage and current, 54
waveforms, 53

gps signal, 21
internal clock, 30
IRIG-B signals, 22
on/off, 24
replacing a fuse, 23
reviewing data, 65

review rate, 69
sag-swell, 73
searching, 71
using PSCSV, 74

setting triggers, 107
setup

autolog, 42
CT/PT, 44
current, 46
custom DST, 45
input, 36
internal clock, 38
optional low current modules, 47
RS-232, 41
tabular results, 51
triggers, 48

setup or configuration, 25
timing modes, 29
USB or RS-232, 31
using display key, 26
using function keys, 24
using hold key, 28
using log key, 27
using numeric keys, 27
using print key, 28
using PSCSV

configuring 933A, 89
linking to pc, 88

using review key, 27
using soft keys, 25
viewing modes, 29

oscillatory transients
detecting, 148

pausing a download, 84
phase balance, description, 144
phase measurement, 141
phasor data, 85, 90, 101
phasor measurement, description, 144
power calculation, 138
power input connector, 18, 23
Power Quality, see measurement
Powering the 933A

ac power cord, 15
battery, 16

PT compensation,
description, 139

Reviewing Data, 65
changing view rate, 69
data selections, 65
downloading, 75
erasing, 66
hold mode, 71
interpreting, 70
locating records, 66
logged, 67
per–second data, 76
sag-swell, 73
searching, 71
selections, 69
waveform records, 78

RMS K, 170
RMS THD, 170
RS-232C, 23

safety information, 12
Sags & Swells, 108, 113
serial channels, description, 147
Setup key, 35
Setup Menus

autolog, 42
CT/PT, 44
current (range), 46
custom DST, 45
custom input, 37
input setup, 36
internal clock, 38
low current modules, 47
real-time clock, 38
RS-232, 41
triggers, 48

Signal Inputs, 20
signal sampling, description, 138
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soft keys, 25
specifications

communications, 128
compensating constants

and ratios, 128
contacts, 130
dsp configuration, 129
environmental, 133
event inputs, 130
flash memory, 129
front panel, 128
input configurations, 127
input connector ratings, 128
input current, 127
input frequency range, 128
input voltage, 127
measurement, 131

accuracy, 132
phasor, 132

physical dimensions, 133
power requirements, 133
protocols, 129
synchronization

GPS, 131
IRIG-B, 130

system frequency, 130
system time, 130
timebase error, 131
VA, Watt, VAR, 128

status indicators, 28
battery level, 28
data modes, 29
date and time, 30
timing modes, 29
viewing modes, 29

status, instrument, 62
stopping a download, 84
support

request, iv
synchronized, 30
synchronizing, 21

using gps, 21
using IRIG-B, 22

synchrophasors, 37
system time deviation, 144

Tera Term Pro, see file transfer
TFTP, 170
THD F, 171
THD T, 171
time (system) deviation,

description, 144
title page, v

Toolbar
flash, 85

Toolbars, 83
broadcast, 84
connection, 84
input, 85
main, 83
records, 86

transformer compensation,
description, 140

triggering, description, 147
Triggers

definitions, sag swell, 114
definitions, user, 111
dependency, 111
erasing, 120
example, waveform, 118
high-speed data capture, 117
hysteresis, 115
logging time, 110
recording data, 107
recording methods, 107
relay settings, 122
sag swell, 108, 113
sag swell reference, 115
setting user, 108
setting with PSCSV, 124
sliding reference, 116
user, 108
user trig definitions, 109
using Aux I/O Module, 120
viewing, 1-sec., 119
waveform capture, 117

Universal Test Plug Current Lead Sets,
7

USB, 3, 19, 22, 31
connecting, 89
description, 147
downloading waveform, 75
specifications, 128

version
manual, v

voltage
fluctuations, 144
inputs, description, 136
lead sets, 5
measurement, 139

warranty, iii
waveform data, see Broadcast

values
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